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Welcome to 
Canoma 

What is Canoma?
Canoma lets you quickly create photorealistic 
3D models from scanned or digital 
photographs, without extensive 3D modeling 
skills. No need for specialized equipment or 
calibrations. Canoma even works on historical 
photographs. Canoma models can be posted 
on Web sites or in electronic catalogs, or 
imported into traditional 3D modeling and 
animation software. Canoma is a perfect 
companion to other Web authoring tools. 

Easier to learn than traditional 3D programs 
(with all their modes, tools, and windows), 
Canoma lets 2D graphic illustrators and 
designers create and manipulate realistic 3D 
models—applying all their retouching and 
filtering skills to 3D objects. 



       
Here’s how Canoma works:

• Take one or more photos of what you want 
to model in 3D. More photos mean greater 
detail. 

• Select 3D shapes (called objects or 
pimitives,) then pin them to the corners of 
objects in your photograph. (There are 
ways to also control edges and alignment.) 

• Preview your 3D creation—move in for a 
close-up look or away, rotate around the 
model, or just walk through it! Canoma 
adds texture to your model right from your 
photographs.

• You can edit areas of texture, letting 
Canoma open your favorite 2D program, 
present you with a head on 2D view of the 
area to edit, then watch as Canoma 
reapplies the edited texture in proper 
perspective! 

• Create animations or export your 3D 
model to other 3D programs or for use on 
the Web. 

What Can You Do with 
Canoma? 
With Canoma you can create very realistic 
three-dimensional (3D) computer models from 
one or more photographs, a process called 
image-assisted modeling. Canoma models have 
simple geometries and use photographs as 
texture source, allowing the pixels to do the 
work of making your models look good. 

Select the face of a Canoma model, bring up a 
2D pixel editing tool, such as Painter or 
Photoshop, and retouch the surface texture, 
add text, or apply a 2D filter. Watch Canoma 
reapply the altered pixels, while retaining 3D 
perspective. 

3D models can be rotated and viewed from 
different directions, allowing customers to 
thoroughly inspect product or merchandise 
models. Once 3D models are completed, you 
can create a simple animation or “walk 
through”, even publish those on the internet. 

Canoma lends itself well to regular, man-made 
objects. Amorphous or very complex shapes 
that may occur in nature such as trees, 
mountains, or curved objects can also be 
approximated, using simple stand-in geometry. 
Canoma also supports translation sweeps or 
extrusion, which allows a polyline contour to be 
swept along a straight axis. 

The Canoma workspace. 
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On-line Catalogs 

You can publish a Web catalog full of Canoma 
models. For example, you could use Canoma to 
create a catalog of “hard goods”, such as 
furniture or appliances, then output it in the 
Metastream format.    

The Metastream format is widely distributed by 
Microsoft and Intel and can be downloaded for 
free from www.metastream.com. Metastream 
uses small, compact files and outputs a single 
file that is easy to maintain and post. 

Streaming a 3D image allows customers to 
experience instant gratification, as they 
manipulate a 3D object. High quality, 
interactive vending, all from within a standard 
Web browser. 

Canoma creates quick, low-polygon count, 
photorealistic models. This can be a fast, cost-
effective way of disseminating information, 
without the security risk that distributing 
detailed blueprints from a CAD program could 
introduce. 

Web Sites, Travel and Tourism, 
Commercial Real Estate 

A 3D preview of property can be a strong sales 
incentive for online travel, real estate sales, or 
vacation rentals. Entertainment, restaurant, 
and hotel information sites all benefit from the 
photorealistic 3D models.  

Examples of models created for catalogs. 

A Canoma model created from a photo of San Francisco. 
The "For Rent" sign was added using a 2D pixel editing 
program. 
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Interior/Exterior Design and 
Remodeling

If the project is to remodel a kitchen, bathroom 
or the outside of a house, a photograph session 
and a quick modeling session—without 
becoming a wizard—creates a model of how the 
project looks right now. Repeat site visits are 
replaced by a photorealistic 3D model, that’s 
always available for a design meeting. 

• Using the texture editing feature, you and 
your 2D pixel editing tool, such as Painter 
or Photoshop, can make changes to 
surfaces or simulate different lighting. 

• With Canoma’s animation feature, you can 
“walk” perspective clients through the 
suggested changes.  

• With a 3D program you can go further, 
changing tiles, sliding in a new dishwasher, 
or actually trying out planned spotlights to 
illuminate that kitchen counter.    

Graphic Design and Advertising 

Industrial design and graphic artists can take 
existing products and packaging, extract the 
graphics, and edit the designs. They can create 
animations or place a package in a different 
environment. 

Walking through a kitchen model. 

Spotlights added to a Canoma model in a 3D program. 

After

Before
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It’s easy to add billboards, place advertising on 
buses, and change details—all in photorealistic 
perspective, using only Canoma and your 
favorite 2D image editing program. You can 
output the results as 3D models, rendered 2D 
images, or even animations.       

Architecture, Urban Planning, 
Property Development 

Architects can produce rough models of areas 
where new buildings are planned, then 
integrate the photorealistic model produced in 
Canoma with the detailed engineering model of 

the planned building, giving everyone a good 
preview of how a building might fit into the 
neighborhood. 

Computer Game Developers and 
3D Artists 

With Canoma, you can quickly model a house 
or office, change some textures, add in a few 
monsters, and really try out ideas. 3D artists can 
use Canoma to create quick photorealistic clip 
objects that can be used to enhance existing 3D 
models and animations. 

Canoma models of complete houses or 
interiors can serve as starting points for more 
detailed 3D modeling, since they provide scene 
measurements and object dimensions. 

You can edit Canoma models with an image-editor. 

A Canoma model generated from a photo of the New York 
skyline can let you see how a new building might look in 
the cityscape. 
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When You Have 
Questions 
You can find answers to most of your questions 
in the following ways: 

• Canoma User Guide - Providing all the 
information you need to get the most out 
of Canoma. The User Guide is also 
provided as a PDF file on the Canoma CD. 

• Online Help - Providing direct access to 
specific chapters in the User Guide. Online 
Help contains the same information as the 
User Guide. Adobe Acrobat Reader 
software is required to read online Help or 
the PDF version of the User Guide. Adobe 
Acrobat Reader software is on the Canoma 
CD or downloadable for free from 
www.adobe.com. 

• Status line tips - Check the bottom of your 
screen for UI related information. 

• Active Guide - Text can pace you through 
the creation and application of your first 
few primitives. The Active Guide goes away 
after you’ve gained some experience or you 
can turn it off in the program preferences. 

About your User Guide
The Canoma User Guide is for both Macintosh 
and Windows. By convention, Macintosh 
commands precede Windows commands in the 
text. For example, Command/Ctrl+I, is 
equivalent to the Macintosh Command-I and 
the Windows Ctrl+I. For simplicity, the term 
“folder” refers to directories as well as folders. 
The Canoma interface for Macintosh and 
Windows platforms is identical, unless 
otherwise specified.

When a modifier key differs between the 
Macintosh and Windows platform, the 
Macintosh modifier is listed first followed by a 
slash and the Windows modifier key. Option/
Alt means Macintosh users press the Option 
key and Windows users press Alt. 

There are several conventions used to identify 
paths to certain tools and controls. The 
convention to a menu follows the rule of the 
menu name > menu item. The convention to a 
palette follows the rule of the palette name: 
subpalette name. The convention to a palette 
menu follows the rule of palette name: palette 
menu> menu item. 

Technical Support
MetaSupport is a portfolio of free and fee-
based support options designed to provide 
quality support to you. 

The options are as follows:

FREE On-line Support

On-line support is available on our Web site at 
www.metacreations.com 24 hours a day, 7 days a 
week. Access a list of Frequently Asked 
Questions (FAQs) for each product and find 
solutions immediately. If, after searching our 
on-line options, you still need assistance, you 
can contact MetaCreations Technical Support 
through one of the Telephone Support Services 
listed here. 

Telephone Support

• Standard Support 

Talk person to person with technical 
support representatives and get answers to 
installation, configuration and general 
usage questions. Each product has its own 
16 Welcome to Canoma 



                             
support duration. The length of the 
complimentary support period depends on 
whether your MetaCreations product is a 
Level I (receive 90 days of complimentary 
support for a first-time purchase, or 30 
days for an upgrade) or Level II (receive 
complimentary support for one incident 
for a first-time or upgrade purchase) 
product. The support period begins with 
your first call into MetaCreations Technical 
Support, provided you have registered the 
product. 

Toll call: 831-430-4200

• Premium Pay as You Go

When your standard support period ends, 
you can now receive priority access 
personal service regarding installation, 
configuration and general usage questions 
from our qualified support specialists. You 
pay a flat fee that covers all of the necessary 
support for the particular incident. 

Toll-free call: 888-456-6382

• Premium Plus Annual Contract

Annual support contracts are available to 
meet your ongoing support needs. Sign up 
for an annual support agreement to receive 
one year of toll-free priority access person-
to-person assistance. Get answers to 
installation, configuration and general 
usage questions.

• To order toll-free call: 800-846-0111

• For support toll-free call: 
800-683-5872

For a list of currently supported Level I and 
Level II products and the Telephone Support 
options pricing, please visit our web-site at 
www.metacreations.com.

Technicians are available Monday through 
Friday, 6am to 5pm Pacific Time.

How to Contact Us 

• Free On-line Support: 
www.metacreations.com

• Standard Support: Toll call 831-430-4200

• Premium Pay As You Go: Toll-free call 
888-456-6382

• Premium Plus Annual Contract: 

• To order toll-free call: 800-846-0111

• For support toll-free call: 800-683-5872

International Support

The telephone support services listed here are 
available only in the U.S. and Canada. However, 
if you live outside of the U.S. and Canada, you 
can still access our free on-line support, and 
you can contact a local MetaCreations 
distributor or other third party that may 
provide technical support in your area. Visit our 
World Wide Web site at 

www.metacreations.com 

for information about how to contact a 
MetaCreations distributor in your country.

Installing Canoma
Installation instructions are provided for both 
Windows and Macintosh. Follow the 
instructions appropriate to your system. 

Note
Canoma is intended for local 
installation only. Do not attempt 
to install it onto a network server. 
17 Canoma



                                         
System Requirements 
(Windows)

• Pentium processor 

• Windows 95, Windows 98, Windows NT 

• 32 mb free RAM (48+ mb recommended) 

• 50 mb of hard-disk space 

• 16 bit color (24 bit recommended) 

• CD Rom drive (for install) 

System Requirements
(Macintosh)

• Power PC 

• System 8.0 or higher 

• 32 mb free RAM (48+ mb recommended) 

• 50 mb hard-disk space 

• 16 bit color (24 bit recommended) 

• CD Rom drive (for install) 

Web Installation

To install Canoma from the Web:

1 Go to the MetaCreations Web site. 

2 Follow the instructions on the Web site to 
download the appropriate self-installing 
executable file (Windows or Macintosh).

3 Double-click the file to run it.

4 Follow the instructions provided by the 
installer. The installation dialog displays an 
important ReadMe. 

5 Click Yes/Accept after reading the 
complete ReadMe. 

Windows CD Installation

To install Canoma from a CD:

1 Launch Windows. 

2 Insert the Canoma CD-ROM into your 
computer’s CD-ROM drive. The Install 
Canoma dialog appears. 

3 Double-click the Canoma icon. 

4 Follow the instructions provided by the 
installer. The installation dialog displays an 
important ReadMe. 

5 Click Yes after reading the complete 
ReadMe. 

Macintosh CD Installation

To install Canoma on a Macintosh:

1 Insert the Canoma CD-ROM into your 
computer’s CD-ROM drive. The Install 
Canoma dialog appears. 

2 Double-click the Canoma icon. 

3 Follow the instructions provided by the 
installer. The installation dialog displays an 
important ReadMe. 

4 Click Accept after reading the complete 
ReadMe. 
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Canoma Installation Tip

• Macintosh tip: Increase available RAM 
available to Canoma by allocating unused 
RAM to Canoma. This can allow Canoma 
to run faster and handle larger files or 
larger renderings. 

Be sure to leave some RAM for the system 
software, though! System software needs to 
be able to dynamically allocate RAM to 
itself when required. 
19 Canoma
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Application 
Overview

Introduction 
Canoma lets you quickly create 3D models 
from scanned or digital photographs. Canoma 
models can then be posted on Web sites, used 
in electronic catalogs, imported into 
traditional 3D modeling and animation 
software, or rendered as 2D image files. 

The Canoma Workspace 
This section leads you through the Canoma 
Workspace. 

The first thing you’ll notice about Canoma is 
that it doesn’t have traditional floating palettes 
and toolbars. All of Canoma’s features are 



        
integrated into the Workspace, which takes over 
your entire screen. This helps keep everything 
uncluttered and easy to locate. 

Your operating system’s standard menus and 
windows are still available from within 
Canoma. You can switch between Canoma and 
other applications, such as 2D paint programs, 
Web browsers, or 3D programs. 

On Windows, Canoma always runs maximized. 
You can’t reduce the window size, although you 
can minimize the Canoma window, using the 
minimize control or switch applications, using 
ALT-TAB or the application buttons in the Task 
Bar. On the Macintosh, you can switch 
applications by clicking inside the window for 
the other application or by using the 
Application List. 

The Canoma Workspace is very flexible. Several 
controls “float” over the Workspace and can be 
moved by dragging them to other locations on 
the application workspace. 

The Canoma Project Window 

The Canoma Project Window is a square 
shaped window inside the Canoma application 
window. It’s where you construct and view a 
Canoma model. 

The Project Window is used when you edit 
your models, manipulating object wireframes in 
Edit mode. It’s your work area where you’ll pin 
3D objects to picture elements. The Project 
Window can be resized to suit your needs (grab 
it by the lower left corner) and moved to 
another part of the Canoma workspace (by the 
title bar.) 

The Project Window is also where you view the 
3D models you create. The view you see of your 
model in the Project Window is taken through 
a stationary “camera.” You can reposition the 
Canoma camera in order to view your model 
from different angles or distances. When you 
view a 3D model, you’re in a three dimensional 
space. That means you can even view your 
model from below or above.

The Canoma Workspace takes over your screen and 
provides access to the Canoma controls. 

The Canoma Project Window is where you construct 3D 
model. 
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Just outside the Project Window are some 
information displays and buttons. Along the 
top of the window is the title of your project 
and its size. To the top right of the window are 
three buttons that toggle display options on 
and off. To the bottom right of the window are 
buttons that let you change the color for 
program elements such as the background, 
selected objects, unselected objects, objects in 
the stress display, shadows, and object 
constraints. 

Camera Controls 

Use the Camera Controls to change the 
position and function of the viewing camera. 

The Edit and View buttons switch between: 

• Edit mode, where you can see the 
wireframe objects that make up your 
model and

• View mode, where you can see the 
untextured or textured 3D model. 

The Camera Crosses let you move the view of 
the camera specifically along X, Y, and Z axis. 
The Camera Trackball lets you rotate the 
camera in any direction and around any axis. 
The Banking and Field of View control spheres 
tilt your Camera and act like a wide-angle lens 
control. Refer to “Positioning the View of Your 
Model” on page 97 for more about positioning 
the camera around your model. 

The Creation Tab

The Creation Tab contains the 3D objects, like 
boxes, rectangles, and even editable polyline 
contours. Select one of these 3D objects, 
position it, then “pin” it to an element in your 
photograph. Once pinned into place, Canoma 

The Canoma Project Window is where you view your 3D 
models. 

Tip If you’re familiar with Bryce 3D 
or Poser by MetaCreations, the 
Camera Controls feel very 
familiar. 

Use the Camera Controls to adjust the position of the 3D 
viewing camera. 
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uses that placement information to create a 3D 
model, which can then be “covered” with the 
pixels from your photographs. 

Refer to “Working with Objects” on page 73 for 
more about the Creation Tab. 

The Toolbar 

The Canoma Toolbar holds the tools you’ll use 
to manipulate objects, view your work, and 
apply or edit textures. Click a button to activate 
that tool.

The Toolbar contains (from left to right):

• Arrow (select, pin, or apply beads)

• Glue (glue objects together) 

• Zoom and Pan (move into, away from, or 
around your scene) 

• Point Pen (add/delete polyline contour 
points) 

• Texture Brush (change textures at a pixel 
level) 

• Quick and Quality Textures (apply 
photograph pixels as textures for your 3D 
scene) 

When a tool is selected, it is highlighted in the 
Toolbar. At the top of the Toolbar is a title that 
identifies which tool is active. 

Selecting Objects

You can use the Object List to easily select an 
object in your scene. The Information button 
brings up a dialog of object settings for the 
selected object. You can even switch into Solo 
Mode, where it’s easier to see just the object 
that you’re working with. 

2D Image Palette

A thumbnail of your photograph is displayed 
on the 2D Image Palette. This is a thumbnail of 
the active image. The 2D Image Palette opens 
downward to reveal all the photographs in your 

Use the scrollbar on the Creation Tab to view all the 
objects you can choose. 

The Canoma Toolbar. 

Click the Information button for object settings, then use 
Solo Mode to focus on one object at a time. 
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project. Refer to “Using 2D Source Images” on 
page 70 for more about using the 2D Image 
Views window. 

Texture Controls

The Texture Controls apply the pixels of your 
photograph to your 3D model. You can use 
Quick Texture (fast) or Quality Texture (slower, 
uses more memory, but looks better.) You can 
also use the Texture Resolution popup to 
choose a resolution setting for the textures you 
apply. 

Refer to “Working with Texture” on page 93 for 
more information about adding Texture. 

The Animation Tab 

The Animation Tab holds the controls you need 
to use in order to quickly define key frames and 
set options to create an animation. Move the 
camera, take a “snapshot,” move the camera, 
take another snapshot, then Canoma completes 
the work by interpolating between the 
keyframes you’ve snapped or “filling in the 
gaps.” 

The Animation Tab contains controls for 
adding and deleting keyframes, a looping 
option, a way to set the playback duration, and 
buttons for previewing your animation. Refer to 
“Previewing an Animation” on page 111 for 
more about the animation controls. 

The Menu Bar 

The Canoma Menu Bar contains eight menus: 
the File menu, the Edit menu, the View menu, 
the Model menu, the Texture menu, the 
Animation menu, the Window menu, and the 
Help menu. These menus provide another 
method of access to the Canoma feature set. 

Status Tips 
As you move the cursor over an element of the 
Canoma workspace, text in the lower right 
corner of the screen explains the purpose of 

The 2D Image palette. 

Choose Quick or Quality Texture, as well as a resolution 
setting. 

The Animation Controls. 
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each. Use Status Tips to “browse” around the 
work area and become familiar with Canoma 
tools, palettes, and dialogs. 

About Canoma 
You can view information about which version 
of Canoma you are using. 

To see Canoma information: 

• Click the word Canoma. 

Accessing the 
MetaCreations Web Site 
You can access the MetaCreations Web Site 
directly from within the Canoma program. 

To access the MetaCreations Web Site: 

• Click the word MetaCreations. This 
launches your browser and opens the 
MetaCreations Web Site. 

Status Tips help you become familiar with Canoma tools, 
palettes, and dialogs. 

Check here for Status Tips
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Tutorial

Welcome
Welcome to the Canoma Tutorial. These 
lessons are designed to introduce you to the 
major features and functions of Canoma. The 
main goal of the tutorial is to teach you all the 
basic techniques you’ll need to use Canoma to 
create 3D models from 2D images. 

Each lesson builds upon skills learned in the 
previous lessons. At the beginning of each 
section is a list of what you have learned up to 
that point. 

Creating a 3D Model
The first thing you need to do is launch the 
Canoma application. Once it appears, Canoma 
displays the Workspace in its default 
configuration. 



For these tutorials, you may want to leave the 
controls in their default positions. Refer to 
“Using the Canoma Workspace” on page 71 for 
more about configuring the Canoma 
Workspace.       

Lesson1: Pinning Corners

To create your first 3D model: 

1 Start Canoma. 

2 Select File menu > New, then select File 
menu > Add Image and open Canoma: 
Tutorials: tutorial1.jpg. 

3 Click the Creation tab. 

4 Click the Box object. A red wireframe of a 
Box is displayed. (Do not click any 
Selection Based Options.) 

To start pinning: 

1 Drag the box wireframe close to the Ray 
Dream Studio 5 box.

2 Click the Zoom button on the Toolbar and 
click the Ray Dream Studio 5 in the 
picture. Zooming in makes the next step 
easier. (Use the Pan tool—the hand button 
on the Toolbar, if you can’t see both the 
wireframe and the Ray Dream Studio box.) 

The Canoma workspace. 

Note
For the sake of clarity in this 
manual, we used higher contrast 
and larger pins in illustrations 
than you will see in the Canoma 
product. 

The Creation Tab. 

The Box object. 

Selecting a Box adds a wireframe object of a box to your 
project. 

The Zoom button. 
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3 Click the Select button (the arrow) on the 
Toolbar, then click and drag a corner of the 
wireframe to a corner of the Ray Dream 
Studio 5 box. A triangle appears when the 
cursor is over a corner of the wireframe. 

This process feels like pinning the corners 
of a springy wireframe to a tackboard using 
push-pins. If you think you made a 
mistake, you can always undo (Ctrl-Z.) 

That's really the main goal—pin as many 
corners of the wireframe as you need to get 
a reasonable match between the wireframe 
and the underlying photograph. 

4 Click and drag the remaining corners of 
the wireframe to corners of the Ray Dream 
Studio 5 box, as shown in the following 

illustrations. Drag each corner in the same 
sequence as is shown below and try to be 
fairly precise. 

Click and drag a corner of the wireframe to a corner of the 
Ray Dream Studio 5 box. 

Drag each corner of the wireframe to a corner of the Ray 
Dream Studio 5 box. 

Continue to drag corners of the wireframe to corners of the 
Ray Dream Studio 5 box. 
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Drag each corner. 

Try to be reasonably precise. 

Drag another corner. 
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Lesson 2: Viewing Progress

To look at the 3D model:

1 Click and drag across the trackball 
controller. You’ll see a shaded 3-D box with 
the correct dimensions. As you drag the 
trackball, the camera rotates around the 
box. 

2 Reset your viewpoint to the one shown in 
the 2D photograph by clicking on the 
photograph's thumbnail. 

3 Click Edit to switch back to Edit mode. 

Lesson 3: Adding Textures and a 
Ground Plane

To add texture to the model: 

1 Click the Quick Texture button (the rabbit) 
on the Toolbar. This applies textures from 
the photograph and automatically switches 
to View mode. 

Texture enhances the model, but the box 
still looks like it’s "flying in space."

To add a ground plane: 

1 Click Edit to return to Edit mode. 

2 Click the Creation tab. 

Drag the trackball to rotate the model. 

Click to return to the viewpoint in the 2D photo. 

The Edit/View buttons switch between Edit and View 
modes. 

The Quick Texture button maps pixels directly from the 
photograph and switches to View mode. 
31 Canoma



3 Click the Rectangle object. 

4 Pin the corners of the rectangle to the 
corners of the gray poster board 
underneath the Ray Dream box. 

5 Click the Quick Textures button to add 
texture to the ground plane. The result is a 
pretty realistically textured 3D model on 
gray poster board. 

6 Use the trackball to preview & rotate your 
model in 3D. 

Use a rectangle for the gray poster board. (Notice that, 
because it’s not selected, the Box object wireframe is now 
yellow.) 

Pin corners. 

Create textures and the box is no longer floating. 

Rotate your 3D model. 
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Filling in the Details
The Story So Far

You learned the basic principle of the Canoma 
program—pin wireframes to photograph 
elements. You also learned how to view, rotate, 
and apply texture to your model. 

In the following section, you’ll learn how to fill 
in areas that are not textured, by adding 
information from additional photographs. 

Lesson 1: Adding a Second 
Image

Using just a single photograph, Canoma could 
not create textures for the back sides of the box 
or for the obscured area of the ground plane. 
Now that you know how to go from wireframe 
mode to View mode and back, it’s time to add 
more textures. 

You can add images from different viewpoints 
to fill in the "bald spots" on any model. Later, 
we’ll discuss other tricks for filling in areas 
where you have no additional photographic 
information. For this tutorial, a single 
additional photograph, taken from behind the 
box is used to complete texturing the model. 

This lesson starts where the previous ended. If 
you still have that project file open, skip ahead 
to “To load another photo:” on page 33. 

To open an existing project: 

1 Select File menu > Open. 

2 Open the file Canoma: Tutorials: 
finished1.3dv. 

3 Click the Quick Textures button. 

4 Use the trackball to rotate the box, so you 
can see the back of the box. The back of 
the box is untextured. To add texture 
information for the back, you need to add a 
photograph of the back of the box. 

To load another photo: 

1 Click the + on the 2D Image Palette and 
load Canoma: Tutorials:tutorial2.jpg. 

2 Click the Creation Tab. 

3 Click the box object. 

Wait! Do not start pinning! 

A new wireframe is now superimposed on 
the second photo, but the alignment is all 
wrong. 

The Quick Textures button. 

The back of the box and the ground plane behind the box 
are untextured. This is because Canoma has no texture 
information for these areas. 
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Your task is to make the wireframe match 
this second photograph. Always look at 
how the wireframe and the photo line up, 
then use the trackball to roughly adjust the 
alignment. Only then can you start using 
pins. 

Aligning the wireframe first saves a lot of 
effort (far fewer pins are needed) and also 
makes Canoma’s mathematics more stable. 

To align the wireframe:

• Use the trackball to rotate the whole model 
about 180 degrees, so you are looking from 
roughly the same viewpoint as the second 
photograph. Notice how the program 
snaps back from Preview Mode to Edit 

Mode as soon as you let go of the trackball. 
It only does this during rough alignment 
(before any pins have been placed.) 

Don’t worry about getting the model 
perfectly aligned. Roughly the same 
viewpoint is fine. If you can see the correct 
face of the box, you’re OK. 

After you release the trackball, the 
superimposed wireframe already matches 
the second image much better. 

Roughly align the new wireframe to the second 
photograph, BEFORE you start pinning. 

First, rotate the whole model about 180 degrees 

.Now that the wireframe is more closely aligned, you can 
start pinning. 
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To pin and texture the second image:

1 Place pins on the corners of the rectangle 
and the box. Place pins first on those 
corners where the fit is worst. 

As you add pins, the rest of the wireframe 
soon fits the photograph. 

2 Switch to View mode, either by clicking the 
View button or by clicking the trackball. 
The 3D camera position matches the 
photograph quite well. 

3 Click the Quick Textures button (the 
rabbit) on the Toolbar to generate textures 
based on both photographs. 

The back side of the Ray Dream Studio 5 
box, as well as the previously obscured 
(white) pieces of the ground plane are now 
filled with texture. Your model might have 
some white boundaries or visible seams. 
More precise pinning helps reduce that, 
but there’s a special texturing trick that can 
also improve the texture quality. More 
about that later! 

4 Use the trackball to verify that you have 
texture all around the 3D model. 

Lesson 2: Modeling Nearby 
Objects

Notice that there is a CD case behind the Ray 
Dream Studio 5 box. This is very typical of real 
world examples. As you add photographs, you 
may discover objects that were partially or fully 
obscured. When that happens, you can choose 
to model the objects. If you don’t model them, 
their image is flattened onto other objects.

Look carefully at the CD case’s texture in the 
3D preview. It looks like a truck drove over it. 

Add pins and the wireframe soon fits the photo. 

Fully textured. 

The CD case is flat. 
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Your next task is to model the CD case. To do 
that, you’ll want to take a look at things up 
close. 

To model the CD case:

1 Click Edit to switch back to Edit mode. 

2 Click the Zoom button on the Toolbar, then 
click and drag the cursor over the area 
where the CD is located. This defines a 
rectangular area to zoom in on. 

3 Create a box. 

4 Pin the new wireframe to the CD case, 
three or four pins should be enough. 

The flat CD is visible from the front, too. 

Drag the Zoom tool to define a zoom area. 

The CD case close up. 

Pin the wireframe to the CD case. 
36 Tutorial 



5 Click the View button and verify the 
existence and size of the new 3D object. 

Up until now, you’ve used Quick Texture. 
Canoma can also create high-quality 
textures. Quality Textures compensates for 
brightness differences between 
photographs that can show up as seams. It 
also fills in white gaps for which there is no 
available information. Quality texturing 
takes longer, but it looks better. 

To use Quality Texturing:

1 Select Texture menu > Quality Resolution 
and choose a 1:1 resolution setting from 
the popup list. 

2 Click the Quality Texture button (the turtle) 
on the Toolbar. 

After textures are generated, they look 
better (although it does takes longer to 
generate them.) 

Lesson 3: Adding a Close-up 
Image

You could stop there, but what if you need 
better textures for the front of the Ray Dream 
Studio 5 box? You might want to animate walk-
through, and for that you’d want more detail. To 
add that detail, you’ll add yet another image. 
The image you’ll add does not show any new 
information, but it does show the front of the 
box in more detail. 

You can imagine doing something similar with 
architectural photographs: 

• first create a model using an aerial 
photograph 

• then add detail with close-ups shots taken 
at ground level. 

To add and pin the third image:

1 Click the + on the 2D Image Palette and 
load Canoma: Tutorials:tutorial2b.jpg. 

2 Roughly align using the Trackball.

3 Click the Ray Dream Studio box to select it 
and pin the visible corners. 

4 Click the gray ground plane to select it, but 
don’t start pinning. 

Close-up views often have the same 
problem. You just can’t see the entire 
photo element you previously modeled. In 
this third photograph, none of the gray 
ground plane’s corners are visible. 

You can use a second (of three) Canoma 
tools to position the wireframe for the 
ground plane. These tools are called beads. 

Check the new CD case model in View mode. 

Click to turn on Quality Textures. 
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To position a wireframe using beads:

1 Move the cursor over any edge (rather than 
a corner) of the wireframe. A little disk 
appears. 

2 Click on the edge of the wireframe to 
create a bead and drag it to the edge of the 
gray ground plane. 

3 Now switch to View mode. 

4 Click the Quality Textures button, and 
select a 1:1 resolution. 

This time Canoma is going to work for a 
while. Once textures are complete, you can 
zoom in on the result. The texture on the 
front of the box is noticeably improved. 

Lesson 4: Editing Textures

Why stop now? You can edit the texture on the 
Ray Dream Studio box, using a 2D pixel editing 
tool, such as Painter or Photoshop. You can edit 
the image in 2D ("head on" view), then Canoma 
automatically displays the results of your edits, 
in proper perspective.  

To edit textures:

1 If necessary, click the View button to 
switch to 3D Preview mode. 

Use beads to position the wireframe for the third image. 

Use beads to position the wireframe for the third image. 

Note
When you edit texture, Canoma 
saves a file of the resulting edit in 
a subfolder, inside your main 
project folder. If you create a 
layered file during editing, you 
may want to save a version of that 
file in another location, just in 
case you need to do any 
additional editing.
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2 Click the Texture Brush in the Toolbar. 

3 Click the face of the Ray Dream box. 
Canoma opens a 2D editing program. 

4 Make a change to the image—change the 
color, add some text, or retouch something. 
You can change the resolution, but don’t 
change the aspect ratio. 

5 Save your work. Save a flattened image file, 
to the same filename as the original. If the 
original was a JPG file and you added text 
or other layers, be sure to flatten the image 
before saving. 

6 Click back inside the Canoma’s program 
window. 

The edited texture is displayed in proper 
3D perspective. 

Creating a Building 
Model
The Story So Far

You learned how to add photographs to an 
existing project, to fill in the gaps. You also 
learned how to roughly align the wireframe to a 
new photograph using the trackball (before any 
pinning!) You learned that fewer pins are 
needed in the additional photographs. You now 
understand the differences between Quick and 
Quality Texturing and between low and high-
resolution settings. You learned how to edit 
textures with a 2D pixel editing program. 

You may have noticed that a red wireframe is 
the "active" or selected one currently being 
pinned, all others are yellow. You know how to 
add close-up pictures to get crisper textures 
and how to add beads rather than pins when 
you cannot see the corners. 

The Texture Brush 

Note
Since this is the first time you’ve 
used the Texture Brush, Canoma 
asks you to choose a 2D pixel 
editing program, such as Painter 
or Photoshop. You can also select 
the application and 2D file format 
using File menu > Application 
Preferences. You can edit the texture with your favorite image editing 

tool 
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In the following section, you’ll try a bigger 
model. This section of the tutorials takes a little 
longer, so reserve some time. The instructions 
describe tricks for modeling some of the 
buildings. You can go further and model other 
buildings for additional practice. A finished 
example file—Canoma: Tutorials: 
finished3.3dv—is available for you to study. 

Lesson 1: Starting with One 
Object

To model the first photograph: 

1 Start Canoma. 

2 Select File menu > New, and open 
Canoma: Tutorials: tutorial3.jpg. 

Start by modeling the main white building. 

To add the first object: 

1 Use the Zoom tool to get a close-up view of 
the white building for better precision. 

2 Click the Creation Tab. 

3 Select the Box object. 

4 Pin the box wireframe to the main part of 
the white building. 

Notice that the building has a notch out of 
the left front corner. It is not a full box. 

Do not model the notch! Keep it simple. 
This is a typical trade-off in Canoma 
between "getting fast results" and "making 
it correct". Quite often, the fast results are 
good enough. 

Since you can’t actually see the corners of 
this building, you must estimate in order to 
put pins where you think the corners are 
located. 

In the last tutorial we suggested that you 
only place pins where you can see real 
corners. Here, by looking at the top edges 
of the building, which are very visible, you 
can safely estimate the location for the 
pins. 

Open tutorial3.jpg. 

Add and pin the first object. 
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Notice that there are structures on top of the 
white building. Now that the base structure is 
pinned, it’s time to model some of the 
structures on top. 

It is important to understand that by default, all 
objects you create sit on the ground, at height 
0. Sometimes, such as in this case, you may 
need to put objects on top of other objects. 

To model objects that are on top of other 
objects: 

1 Make sure the white building wireframe is 
selected, i.e. that the wireframe is red. If it 
is yellow, click to select it. 

2 Click the Creation Tab. 

3 Click Stack in the Selection Based 
Options, then select the Box object.  

4 Pin this box to the relatively flat 
superstructure that sits on top of the 
building. 

5 In View mode, click Quick Texture. 

To create the ground plane:

1 Click the Creation Tab.

2 Click the Floor Rectangle object to create a 
flat rectangle that’s large enough to be the 
ground plane for your entire scene. 

3 In View mode, click the Quick Textures 
button. 

Using the Stack option places a new object on top of the 
active object. 

Pin the “on-top” box to the flat structure on top of the 
building. 

Add Quick Texture. 
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Lesson 2: Completing the Job

Now that you’ve modeled part of the building, 
you can go on to model the rest of the 
photograph. 

A Few Things to Remember

• In general, the first few objects really help 
Canoma determine the camera viewpoint 
and perspective. Larger objects, with well 
defined perspectives allow better operation 
than smaller objects or objects viewed 
head-on.

• Remember to always model objects from 
the ground up. First model the base of a 
building, then create a pyramid or roof on 
top of that. 

• You can also establish perspective early on 
by using a temporary object, such as a large 
ground plane, to show Canoma the 
vanishing directions (how parallel lines 
such as the roads converge.) You can delete 
the temporary object after the rest of your 
modeling is complete. Like removing a 
scaffold after real-world construction. 

Reducing Confusion 

As you add more objects, some with objects on 
top of them, the wireframe display can get 
cluttered. Here is a trick to reduce the 
confusion. 

To use Solo Mode: 

• Click the Solo Mode button to dim all 
wireframes except the one you are 
currently working with (the selected one, 
in red.) 

The Solo Mode button is only available 
when there is more than one object in your 
scene. 

To switch from Solo Mode to normal editing: 

• Click the Solo Mode button again. 

Even while you are in Solo Mode, when you 
move the cursor over other areas of the 
photograph, existing, but currently hidden 
wireframes, temporarily show up outlined in 
yellow. 

Continue to model structures in the photograph. 

The Solo Mode button. 
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This color-coding lets you see where objects are 
located and also lets you quickly select one for 
further work, without having to switch between 
Solo and regular editing Mode. 

Lesson 3: Navigating Through a 
Model

You know how to use the trackball to rotate a 
3D model. There are other ways to navigate 
through a model. 

Using the Cross Control 

Camera Cross controls let you move the view of 
your model along specific axes. When you’re 
using these controls, the view does not tilt or 
rotate from its original position. It only moves 
up, down, back, or forward. 

Just play around with the Cross Controls - you 
can always reset to the viewpoint of a particular 
photograph by clicking on its thumbnail. 

The Banking control sphere tilts your Camera 
(really rotating the camera on the Y axis,) 
creating the effect of a tilted horizon. This 
control is great for creating tilted airplane 
cockpit views. Banking simulates a Roll action. 

The Field of View control sphere acts like a 
wide-angle lens control. The higher the setting, 
the wider the field of view for your lens. 

Use Solo Mode to reduce confusion. 

The final project. 

The Cross Controls. 

The Banking Control. 
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Canoma’s Field of View control automatically 
adjusts the distance, so that objects in the 
center stay about the same size. 

Aligning Objects 
Precisely
The Story So Far

In the previous lessons, you learned how to 
create objects on top of other objects. You 
learned how to use Solo Mode to help you 
remain focused on desired objects. You learned 
how to add a ground plane even when there are 
no good corners visible and how to use beads 
instead of pins when you need to model a 
partial object. Finally, you learned how to 
navigate through your models using the Cross 
Controls, the Banking Control, and the Field of 
View Control. 

In the following lessons, you will learn how to 
use glue to align objects precisely. 

Lesson 1: Using Glue

You are about to make a model of a building in 
Washington, DC. You will use glue to align 
objects precisely. 

To start with the 2D image: 

1 If you haven’t already, select File menu > 
Close to close the previous tutorial. 

2 Select File menu > New.

3 Load Canoma: Tutorials: tutorial4.jpg. 

To start modeling: 

1 Model the base of the red building, using a 
Box. 

You cannot really see the front bottom or 
the back top corner, so you can use beads 
for the edges there. 

2 With the first wireframe still selected, click 
Stack and Aligned in the Selection Based 
options on the Creation Tab, then create a 

The Field of View Control. 

Tip
You can also navigate right in the 
Project Window. Refer to “Using 
the In-View Navigation Controls” 
on page 99 for another way to 
navigate around your model. 

Model the base with a box. 
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Box and pin it. Use a bead to raise the top 
of this second wireframe to the proper 
height. 

The next step is to model the small 
structure on top. 

3 With the second wireframe still selected, 
click Stack and Aligned in the Selection 
Based options on the Creation Tab, then 
create a Box and pin it. 

Since the bottom corners of the third box 
coincide with the top of the second box, 
you can use glue rather than pins to give 
them approximately the same location.

To glue the third box to the second: 

1 Click the Glue button (the glue bottle) in 
the Toolbar. 

2 Click and drag a bottom right corner of the 
topmost box. 

3 Move that corner over the edge of the 
second box. A little yellow bead is visual 
feedback that you are gluing to the edge of 
the box. 

4 Let go of the mouse button. 

The next step is to create a roof on top of the 
topmost box. 

To glue on the first roof: 

1 With the topmost wireframe box selected, 
click Stack and Aligned in the Selection 
Based options on the Creation Tab, then 
create a Roof. 

2 Click the Glue button (the glue bottle) in 
the Toolbar. 

3 Click on the right-front corner of the roof 
wireframe and drag it to the top-right-front 
corner of the topmost box. 

You’ll see a yellow pin that indicates you 
are gluing, rather than pinning, the roof to 
the box. When you release the mouse 
button, a circle shows that the corner is 
glued. 

Use a bead to estimate the edges. 

Tip
Since you know that each section 
of the Red building is aligned 
with the rest, using Stack/Align 
for the second wireframe tells the 
program that the elements are 
aligned, which creates a better 
model.

Circles tell you that the object is glued to the one below. 
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4 Now do the same thing for the right-back 
corner of the roof and the left-front corner. 

Do not pin or glue the left-back corner of 
the roof. Since it can’t be seen, it’s not a 
good idea to introduce a pin or glue that 
could easily be inaccurate. 

5 Now fix the height of the roof. You could 
use a pin in the front top corner or a bead 
on the top edge, but a bead is better in this 
case. 

6 Switch to View mode to see the results. A 
perfect fit. If things went awry during this 
step, use Undo (ctrl-Z) and try again. 

Now it’s time to put a roof on the second 
level of the building. 

To add a final roof: 

1 Select the second Box that you created (the 
middle level of the building.) 

2 Click Stack and Aligned in the Selection 
Based options on the Creation Tab, then 
create a Roof. 

Wait! the orientation of the Roof wireframe 
is all wrong. That’s probably going to 
happen a lot, but it’s easy to correct the 
orientation. 

3 With the roof wireframe still selected, click 
the object information button or select 
Edit menu > Get Information. 

The Object Information dialog is 
displayed. 

Note
In real life the roof extends 
beyond the edge of the building. 
Model the roof to be the same 
length and width as the building. 
Don’t force the roof out past the 
edge of the box with a pin. Refer 
to “Avoiding Model Stress” on 
page 92 for more about how to 
avoid introducing unnecessary 
stress into your Canoma model. 

With three corners glued to the box, the roof’s orientation 
is fixed. 

The object information button. 

The Object Information dialog. 
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4 Click the Rotate by 90º around Y-Axis 
button. 

5 Now that the orientation of the wireframe 
is correct, glue the roof as you glued the 
previous roof. Glue only the three visible 
corners of this part of the building. Model 
the roof to be the same length and width as 
the building, ignoring any "real life" 
overhang. 

6 Use a bead to "pull up" the roof to the 
correct height. 

7 Switch to View mode, select Quality 
Textures, with a 1:1 resolution and create 
the textures for your model. 

8 Congratulations!

(If you get good at this, you can do this 
whole part of the tutorial, with texturing, 
in under two minutes. Refer to “Setting 
Selection Based Options” on page 84 and 
review the Concentric option for 
information about another feature that can 
save you time when you’re creating 
models.) 

Picking Up Speed
The Story So Far

You learned how to use glue for precise 
alignment (both corner-to-corner and corner-
to-edge). You learned how to notice and avoid 
inconsistent input. 

In the following lessons, you’ll learn how to 
speed up modeling by duplicating similar 
elements in a photograph. You’ll learn to use 
glue to precisely connect shapes. 

You’ll learn the importance of modeling large 
scale features first, even if your early models are 
only used as stand-ins, for more detailed 
models later. After establishing good 
perspective, you can delete temporary objects 
and replace them with successively more 
detailed models. 

Lesson 1: Duplicating Similar 
Elements

To start with the 2D image: 

1 Select File > New to create a new project. 

2 Load Canoma: Tutorials: tutorial5.jpg. 

You’ll recognize the red building from the 
previous tutorial, but now you’ll model the 
whole area surrounding the red building. 
The trick is to model large structures first, 
as that establishes good perspective for 
Canoma. Only then should you proceed 
with more detailed models. 

To model around the red building: 

1 Create and pin a Box on both the larger 
building at the top of the photograph and 
the red building in front. This sets the 

The final results. 
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perspective for your scene - as you add 
more boxes, they should "fall into place" 
with only a few pins. Instead of completing 
this building, proceed with one of the two 
identical H-shaped buildings right behind 
the red one. 

2 Use a single box for the first H-shaped 
building and pin it into place. 

3 Assume that the two H-shaped buildings 
are symmetrical and aligned. Instead of 
just using create box, keep the H-shaped 
building’s box selected and press Shift + 
Cmd/Ctrl D to create an aligned duplicate 
of the selected box. 

4 All you need to do is pin this duplicate to 
the other H-shaped building. Two pins are 
probably sufficient, because all other 
dimensions are known to Canoma from the 
first H-shaped Box. 

Use Edit menu > Duplicate when you are 
sure two objects have the same 
dimensions. 

Use Aligned Duplicate (Shift + Cmd/Ctrl 
D) when the dimensions and alignment are 
both identical. This reduces the number of 
pins needed to place wireframes and at the 
same time makes your 3D model more 
precise. 

5 Create a box for the first small square-
shaped building. 

Use a single box for the first H-shaped building. 

Tip
If you zoom in on a building 
before you create an object, the 
object gets created close to where 
you need to place it.

Use Aligned Duplicate (Shift + Cmd/Ctrl D) to create the 
second H-shaped building. 
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6 Use aligned duplicate (Shift + Cmd/Ctrl D) 
again for the second square-shaped 
building. 

Now you have 5 Boxes across the whole 
picture. 

7 Rotate the model in View mode to check 
whether the dimensions match your 
expectations. This helps to verify whether a 
reasonable perspective was established. 

If the perspective seems squashed or 
stretched, it’s probably off. If that happens, 
it is probably best to start over. Which is 
not so bad, since you’ve only had to place a 
few Boxes. 

Lesson 2: Adding Detail

What if you want to model in more detail? 
Once you are satisfied that Canoma has a good 
perspective, you can delete the "stand-in" or 
rough models you have just created, then 
replace them with more detailed models. 

To add more detail: 

1 Select one of the H-shaped Boxes and 
press the Delete key or select Edit menu > 
Clear. 

2 Zoom into that area of the photograph.

3 Create a Box and pin it to the far end of the 
building. 

Use aligned duplicate (Shift + Cmd/Ctrl D) whenever 
possible. 

Tip
It’s a good idea to model large 
objects around the entire 
photograph first, to establish 
perspective. Don’t start modeling 
in great detail in one corner of a 
photograph, because it’s easy to 
imprecisely place a pin, causing 
Canoma to estimate a wrong 
perspective. 

Verify perspective. 
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4 Use Align Duplicate to create a Box for the 
near end.

5 Create a Box for the center. 

6 Since you know the building parts border 
each other, click the Glue button on the 
Toolbar to glue (not pin) top corners of the 
center box to the nearest top edge of the 
end boxes. 

7 Now use a bead for the center Box’s bottom 
edge, to slide it into the right place. 

You could have modeled each of the 3 
Boxes separately, but it would have been 
more work and they might not have 
aligned as nicely as they do now. 

You can now model the second H-shaped 
building in more detail, using the same 
techniques. 

Lesson 3: Adding a Ground 
Plane

Finally, add a ground plane the same way you 
did in the 3rd tutorial. 

To create the ground plane: 

1 Create a Rectangle.

2 Pin the far corner to the street corner at 
the far end (near the two red cars.) 

3 Use beads to stretch the rectangle around 
all your buildings.

Parts of the rectangle now extend outside 
the photograph - that's fine. 

4 Switch to View mode. 

5 Select Texture menu > Mirror Textures. 

This tells Canoma to “steal” the texture 
from another place on the object, since 
pixel information is not available. 

Duplicate and Aligned Duplicate are your friends! 

Tip
As a finger exercise, complete the 
red building model in the front.

It’s OK if parts of the rectangle extend outside the 
photograph. 
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6 Click Quality Textures buttons, with a 
resolution of 1:1 to create the textures. 

7 Rotate the model. You may be surprised. 
The back sides of the building, which were 
not visible in the photograph, are now 
textured. Canoma actually “mirrored” 
textures from elsewhere and did a pretty 
good job. 

                                                                              

Looking good! 

Before Texture menu > Mirror Textures is used 

After using Texture menu > Mirror Textures. Canoma 
“steals” textures from a portion of the model where 
textures are available, then applies them to non-textured 
sides. 
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4  

Canoma
Basics

Introduction
This chapter describes how to setup Canoma 
and shows you some basic techniques you’ll 
need to know in order to create 3D models. 



Customizing Canoma
Setting Canoma Preferences

Set Application Preferences to suit the way you 
like to work. 

To open the Canoma preferences dialog: 

• Select File menu > Preferences to display 
the Application Preferences dialog. 

Saving Workspace 
Customizations 

Canoma is intended to be a flexible, creative 
tool, so there are many ways you can customize 
it to suit your style of working. Move toolbars 
and palettes, resize the project window, or 
choose a color scheme. 

The Maintain Custom Configured Workspace 
option toggles between discarding those 
changes or keeping them from session to 
session. 

To save changes you make to the Canoma 
workspace: 

1 Select File menu > Preferences to display 
the Application Preferences dialog. 

2 Click the Maintain custom configured 
workspace option. A checkmark indicates 
that the option is selected. 

The next time you start Canoma, your 
workspace is as you left it when the 
application was closed. 

To discard changes you make to the Canoma 
workspace: 

1 Select File menu > Preferences to display 
the Application Preferences dialog. 

2 Click the Maintain custom configured 
workspace option. No checkmark is 
displayed when the option is not enabled. 

The next time you start Canoma, your 
workspace is displayed in the default 
configuration. 

Setting Canoma preferences. 

Save or discard changes you make to the workspace. 
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Using the Active Guide 

When you start creating objects and affixing 
them to photo elements, you can get some help 
from the Active Guide. This handy window 
offers tips to pace you through the creation and 
pinning of your first few primitives. 

To turn the Active Guide on or off:

1 Select File menu > Preferences to display 
the Application Preferences dialog. 

2  Click the Display Active Guide option. A 
checkmark indicates that the option is 
selected. 

Choosing a 2D Image Editing 
Application and Image Format 

Make subtle or major changes to the texture of 
a 3D modeled scene, using your favorite 2D 
pixel editing program or use Canoma to keep 
that 3D look, without creating a 3D scene. Edit 
an area of texture, then have Canoma display 
the results in proper 3D perspective. What a 
time saver! Refer to “Retouching or Editing 
Textures in 2D” on page 103 for more about 
editing a perspective image.

Select a default 2D pixel editing application, 
such as Painter or Photoshop. The default 2D 
pixel editing tool is opened whenever you use 
the Texture Brush from the Toolbar to edit the 
texture on the face of an object. 

You can also select a Default File Type to be 
used for the image files generated when you 
edit textures. 

To select a 2D image editing application: 

1 Choose File menu > Preferences. 

2 Click the Browse button and navigate to 
select a 2D pixel editing program. 

3 Click Apply. 

To choose a default 2D Image File Type:

• Click the Image Format drop down list and 
choose a format. 

Setting Up Your 
Workspace 
Working in the Project Window 

In Edit mode, Canoma’s Project Window shows 
the active photograph and any 3D wireframe 
objects you have created and placed. In View 
mode, the Project Window shows your textured 

The Active Guide offers tips to help as you create and pin 
objects. Selecting a 2D editing application. 
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or untextured 3D model. Refer to “Using the 
Canoma Workspace” on page 71 for more about 
the Project Window. 

Using the Camera Controls 

The Camera Controls are used to position and 
rotate the camera that views your model. They 
can be repositioned on the workspace. Refer to 
“Using Canoma Camera Controls” on page 98 
for more information about how to use the 
Camera Controls. 

Understanding the Toolbar

The Canoma Toolbar holds the tools you’ll use 
to manipulate objects, view your work, and 
apply or edit textures. The Toolbar can be 
repositioned on the workspace. Refer to “The 
Toolbar” on page 24 for more about the 
Canoma Toolbar. 

Changing Canoma Colors 

You can customize the colors that Canoma uses 
to display application elements. Use the color 
selection buttons outside the lower right corner 
of the project window to select a color scheme 
that works best for you. 

To change the background color: 

• Click the Background Color button, then 
select a color. The default background 
color is dark gray. 

The Project Window in 3D Preview mode. 

You can move the Camera Controls to another place on the 
workspace. 

The Canoma Toolbar. 

Click to change the background color. 
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To change the color used to highlight the 
selected object: 

• Click the Selected Object Color button, 
then select a color. The default selected 
object color is red. 

To change the color used to highlight 
unselected objects: 

• Click the Unselected Objects Color button, 
then select a color. The default unselected 
object color is yellow. 

To change the color used for objects in the 
stress display: 

• Click the Stress Display Color button, then 
select a color. The default stress display 
color is white. Refer to “Avoiding Model 

Stress” on page 92 for more about using 
the stress display to check for errors that 
place stress on the 3D model. 

To change the color used for shadows: 

• Click the Shadow Color button, then select 
a color. The default shadow color is light 
gray. Refer to “Using Shadows” on page 91 
for more about wireframe shadows. 

To change the color used for highlighting a 
selected object constraint: 

• Click the Selected Constraint Color 
button, then select a color. The default 
selected constraint color is cyan. When 

Click to change the selected object color. 

Click to change the color of unselected objects. 

Click to change the stress display color. 

Click to change shadow color. 
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you move the cursor over a constraint, 
such as a bead or pin, the selected object 
constraint color is used. 

Creating a Canoma 
Project
A Canoma project is made up of photograph(s) 
or image(s) over which 3D primitives are 
projected. Refer to “Working with Canoma 
Projects” on page 72 for more about creating a 
new project or opening an existing project. 

Organizing the Project Folder 

It’s a good idea to create a project folder, before 
beginning work on your 3D model. A main 
project folder holds all of the photographs your 
project requires, as well as the Canoma project 
file (when saved.) 

Because Canoma expects all project files to 
reside at the same hierarchical level, do not 
place photographs in a subfolder and take care 
to save the project file so that it resides in the 
main project folder. Any subfolders that are 
required by the project are created within the 
main folder by Canoma. 

Using 2D Images
When you create a Canoma project, you’ll start 
by loading a photograph. This first photograph 
lays the groundwork for further work. Images 
are stored in the 2D Image Views palette. The 
2D Image Views palette can also be 
repositioned on the workspace. Refer to “Using 
2D Source Images” on page 70 for more 
information about that palette. 

If you need better textures for the front of a 
building or the side of a box, you can add more 
detailed texture by adding photographs. For 
example, you might want to add detail for one 
side of a building, to show what offices are 
available. Refer to “Adding More Detail” on 
page 94 for more about using additional 
photographs to add detail. 

Creating 3D Models
The goal of Canoma is to make 3D wireframe 
primitives match underlying images. To do that, 
you pin the corners of wireframe primitives, 
such as boxes or pyramids, to get a reasonable 
match between the wireframe and the 
photograph. Refer to “Using the Canoma 
Workspace” on page 71 for more information 
about building 3D models. Refer to “Modeling 
Objects” on page 113 for some interesting 
modeling techniques. 

Click to change the selected constraint color. 

The 2D Image Palette. 
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Once created, you can view it as a 3D model, 
using Canoma’s camera controls. Refer to 
“Using Canoma Camera Controls” on page 98 
for more information about viewing your 
models. 

Adding Texture
Adding texture is the process of mapping pixels 
of an underlying image to the surface of an 
object, without changing that object’s geometry. 

Canoma offers two types of texturing: Quick 
Texture and Quality Texture. Quality texturing 
compensates for brightness differences 
between photographs that can show up as 
seams. It also fills in white gaps for which there 
is no available information. Quality texturing 
takes longer and takes more memory, but it 
looks better. Refer to “Working with Texture” 
on page 93 for more information about adding 
surface textures. 

Refer to “Retouching or Editing Textures in 
2D” on page 103 for some great tips about 
editing areas of texture in a 2D program. 

Creating Animations
Animation is the process of recording the 
motion of the camera as a 3D model is being 
viewed. 

To create an animation: 

• Complete a 3D model.

• View it. 

• While viewing, record keyframes. 

Canoma creates a motion path from your 
recorded camera movements and then 
generates an animation. Refer to “Creating an 
Animation” on page 110 for more information 
about creating animations. 

Undoing Operations 
The Undo command and the Revert to Saved 
command let you discard the effects of changes 
you’ve made to your model. 

You can Undo an operation up to 10 times in a 
row. You can also Redo what you’ve undone. If 
you’ve made changes and change your mind 
completely, you can discard any changes you’ve 
made, without exiting the program. 

Canoma uses pixel information from the photograph to 
apply texture to a model. 

Use the Texture Brush to select an area to edit in a 2D 
pixel editing application, such as Painter or Photoshop. 
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To undo the last operation:

• Choose Edit menu > Undo (or press Cmd/
Ctrl+Z).

To redo the last operation:

• Choose Edit menu > Redo.

To revert to the last saved version of your 
model: 

• Select File menu > Revert to Saved. 

Saving and Closing 
The Save command lets you save your work. 

Saving the Project 

To save a project file:

1 Choose File menu > Save. 

2 Use the Save dialog controls to choose a 
location for your work, then click Save. 

Be sure to save the project file so that it 
resides in the same folder as the project 
photographs. Canoma assumes that all 
project files are at the same hierarchical 
level. 

To save a file under a different name: 

1 Choose File menu > Save As. 

2 Enter a new name and/or location in the 
fields provided and click Save. 

A copy of your work is saved, leaving the 
original intact. 

Be sure to save the new project file so that 
it resides in the same folder as the project 
photographs. Canoma assumes that all 
project files are at the same hierarchical 
level. 

If texture was edited with a 2D pixel 
editing program, such as Painter or 
Photoshop, the resulting files from those 
edits are placed in a subfolder created by 
Canoma. This subfolder’s name matches 
the new project name. If you do not want 
texture edits to apply to the copy, remove 
the texture edit files or remove the entire 
subfolder. 

Closing Canoma

To close Canoma: 

• Choose File menu > Quit, or press Cmd-
Q/Ctrl+Q. When you close the application, 
Canoma asks if you want to save your work. 

Importing, Exporting, 
and Rendering 
Importing

Canoma supports the following 2D file formats 
for import into your model: 

• JPG 

• TIFF (includes alpha information) 

• PNG (includes alpha information) 

• GIF (includes alpha information) 

• PSD (includes alpha information) 

• BMP (Win only) 

• PICT (Mac only) 
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Exporting

When you export your Canoma model for use 
on the Web or in another 3D program, Canoma 
automatically creates a folder to hold the 
various files that are created. 

With Canoma, what you see is what gets 
exported. If you edit textures after emitting a 
model, those image files are not picked up by 
the exported model. If Texture menu > Mirror 
Textures is Off, untextured surfaces are 
untextured in the exported file. If Texture 
menu > Mirror Textures is On, untextured 
surfaces will be filled with pixels from the 
corresponding side. 

Canoma supports the following file export 
formats: 

• MetaStream (for posting on the Web) 

When exporting to MetaStream, two file 
formats are generated:

• HTML which embeds (using the 
EMBED tag) MetaStream output 
generated by Canoma 

• MTS file containing compressed 
geometry and textures. 

Double-click the HTML file to open the 
output. 

The proper usage of MetaStream objects is 
as embedded objects in a HTML page. This 
gives the page author full control over a 
wide range of rendering and interaction 
options described at the MetaStream Web 
site (http://www.metastream.com). If you 
were to just open a raw MTS file, the plug 
in runs with all attributes set to default 
values, which is unlikely to be correct for 
all cases. 

Textures generated by Canoma are already 
lit (by real light) and do not need to be 
additionally shaded by synthetic lights, so 
texture shading is set to off. 

Infini-D: If Infini-D is installed, the MTS 
file appears with an Infini-D icon and 
launches the application when double-
clicked, so just double-click the HTML file. 

Make sure the path and the filename are 
correct and that all required libraries are 
available or an error message is displayed. 
Should that happen, just open the HTML 
file. 

• OBJ file format (for import into Poser, 
Bryce 3D, Ray Dream Studio, and other 3D 
programs) 

Ray Dream Studio: The geometry and 
textures import nicely, but the bounding 
boxes are drawn incorrectly. 

Poser: Exports to Poser Prop export a.pp2 
file and several .bmp (Win)/.pict (Mac) 
textures. You then need to manually copy 
or move the.pp2 file to any immediate 
subfolder of Runtime\libraries\props and 
move or copy all the .bmp or .pict files to 
<PoserAppDirectory>\Runtime\textures\. 
The Canoma generated object or scene 
appears in the list of props (without a 
special icon) and the name you give the 
prop. You can place & work with the prop 
like any other. To make things simpler: 
Keep shortcuts/aliases to the Poser texture 
and prop type folders handy to where you 
generate the prop file, then just drag the 
files onto the shortcuts - faster than 
hunting the directory down. One word of 
caution: don’t name two Canoma 
generated Poser props the same name or 
you will overwrite part of the other props 
textures.

Maxon Cinema: Maxon Cinema imports 
the OBJ geometry ungrouped and 
untextured.

NewTek Inspire 3D modeler: NewTek 
Inspire 3D modeler loads the geometry 
untextured. 
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• VRML 2 (for use in Cosmo 2.1, Blaxxun 
Community Client, Visscape Superscape 
VRML, and 3D Studio Max) 

Textures generated by Canoma are already 
lit (by real light) and do not need to be 
additionally shaded by synthetic lights, so 
texture shading is set to off. 

The VRML that is exported contains one 
viewpoint for each source image and also 
an extra one for the current 3D view 
camera (which need not coincide with any 
source image point of view.) Typically, 
VRML browsers let you step between 
viewpoints. Consult your Browser 
documentation for details. For example, in 
Cosmo 2.1, PgUP and PgDn go to the Next/
Previous viewpoint. 

If you created an animation in Canoma, the 
starting point of the animation gets 
recorded in the VRML as a special 
viewpoint called “Tour.” After selecting 
“Tour” as your viewpoint in the VRML 
browser, click anywhere in the scene to 
start the animation you had in Canoma. 
After the animation is finished, the “Tour” 
automatically returns to the starting point, 
ready for another “click” to start it again. 

Canoma exports VRML files as text files. 
Typically, these are not large compared to 
the associated texture files, but you can 
gzip the WRL file for extra compression, 
using the 3rd party gzip software utility. 
Remember to rename the .wrl.gz file 
extension back to .wrl, even though it is 
now compressed. Browsers use this 
extension to route contents to the correct 
plug-in (in this case VRML.) 

If you import Canoma models into a 3D 
modeler and the objects seem too bright, 
either turn texture shading off altogether 
or attenuate your texture light emission. 

• Caligari trueSpace 3D 

All objects are exported as one group. All 
image viewpoints are saved as cameras in 
TS4. The first four are opened as views in 
the workspace. Canoma exports to .scn 
files, to load scenes. If you want to create 
separate reusable objects, load scene, 
ungroup, and Save Selected Objects as 
.cob files. 

Due to a problem in TS4.0, some textures 
may display black. Registered users can 
upgrade to 4.1 by contacting Caligari 
directly. This fixes the problem. 

• AutoCAD DXF 

Files exported as DXF may import into 3D 
applications very small. In some cases, you 
can adjust the DXF units during import. In 
most cases, you should scale the model. In 
a very specific case using Artifice Design 
Workshop, the imported DXF model 
imports objects ungrouped. Group the 
model before scaling. 

Rendering 2D Images 

You can produce a 2D image of your Canoma 
scene. When a 2D image is rendered, Canoma 
automatically creates a folder into which it 
saves any associated image files. 

When you render an image, a popup menu 
with output file size choices is displayed. Any 
rendered image is locked to the aspect ratio of 
your project window. 

To render a 2D image of your model: 

1 Select File menu > Render Image. 

2 Set the desired size. 
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Rendering Animations 

You can produce a QuickTime movie of camera 
movements around your Canoma scene. When 
an animation is rendered, Canoma 
automatically creates a folder into which it 
saves any associated animation files. 

When you render an image, a popup menu 
with output file size choices is displayed. Any 
rendered image is locked to the aspect ratio of 
your project window. 

At the time you render an animation, you can 
edit the module, setting additional options, 
including animation compression and frame 
rate. 

You can also select to output your animation as 
a sequence of image files. 

To render an animation: 

1 Select File menu > Render Animation. 

2 Set the desired size. 

3 Select between outputting a QuickTime 
animation or a series of keyframe images. 

Selecting to output as a series of keyframe 
images outputs single image files for each 
keyframe (BMP on PC, PICT on Mac). This 
generates as many single files as there are 
frames in your movie. 

4 Press Edit, to edit the module you just 
selected. 

Note
To render an animation, 
QuickTime 3.0 must be installed. 
It is available on the Canoma CD, 
or can be downloaded at 
www.apple.com. 
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5  

Preparing 
Projects

Taking Photographs 
Good photographs are an important part of 
using Canoma to create models. As you 
venture on your own to make photographs, 
here are a few suggestions to help assure a 
successful project. 

What Works Best 

Canoma does best with objects that have sharp 
corners, rather than round ones. The trouble 
with round corners is that you can’t really tell 
exactly "where the corners are". This is 
especially true if you have multiple images. 

Canoma expects you to pin the same 
corresponding points in all photographs. 
Sometimes you can fake it and use beads or 



other techniques to tell Canoma where corners 
might be located. However, if you keep “sharp 
corners” in mind, you won’t be disappointed. 

Using Several Photographs

One of the best pieces of advice is not to be 
afraid of taking too many photographs. Photos 
are cheap, especially in this age of digital 
cameras, compared to redoing a photo shoot. 
Inevitably, some photos won’t turn out as well 
as others and you’re bound to need detail 
where you didn’t expected to need it. The best 
reward for taking as many photos as possible is 
the time and frustration you’ll save when you 
have lots of choices during modeling. 

Varying the Angles

When you take several photographs of a single 
object or building, try to take them from very 
different angles. For example, take one from the 
front, then another from the side at a 90 degree 
angle from the first. This allows you to put pins 
for the same corners in multiple images, 
allowing Canoma to give you precise models.

Using a “Panorama” Approach

When you take photographs of a room or 
enclosed space, stand in one place and take 
some from the same position. Turn your head a 
little bit each time, just like you would if you 
were creating a panorama. 

As you use this approach, make sure that you 
have some overlap between photographs. In 
particular, make sure that at least one object is 
visible in any pair of adjacent photographs. 
This is because you have to match up a model 
made from one photograph with something in 
the next photograph. Having an object on the 
left or right border makes the job much 
simpler. 

Working from Overviews to 
Detailed Photos

Overview Photos

Be sure to take plenty of overview photos. 
When you start modeling, you should start with 
an overview photo. Using overview 
photographs can make initial modeling easier. 
It can be difficult starting with a close-up view. 

As you take overview photos of a scene, try to 
get at least some objects fully into view, so you 
can see their corners. If you cannot see corners, 
make sure you can at least see edges, for 
example where two walls meet or a wall and the 
floor. Also, try not to get too far away from the 
scene, since details fade and distortion sets in 
the further away you get from your subject. 

Canoma works best with sharp corners. The object on the 
right has sharp corners and will give the best results when 
modeled. 

Tip
It is also a good idea to create 
pictures with different exposures, 
in order to avoid big contrasts 
later. That way, you can select 
those that match best. 
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Detailed Photos

When you need for a particular object in your 
model to have better textures, be sure you take 
extra close-up photographs of that object. 
When taking close up photos, try to keep the 
whole object in the photograph. Also, try to 
take a close-up from right in front of the 
surface. 

For example, say you want to get a high-
resolution version of a painting on your wall. 
Let us assume you already have pictures of the 
room, complete with edges and corners of the 
walls, which you used to model the wall and 
painting. 

Take a close up image of just the painting, 
making sure you see all of it and perhaps its 
frame. Add that close-up to your model and pin 
the corners of the painting. Canoma 
automatically uses your close-up shot to get the 
best texture resolution. 

Don’t Move Things

This sounds simple, but try to take pictures of 
the same things. Don’t move chairs, boxes, cars 
or anything while you’re taking pictures. 
Canoma assumes objects do not move between 
photographs. 

One Photo, One Image File

Use only one photograph per image file. If you 
used a scanner to digitize photos, don’t scan 
more than one photo into a single image file. 
You can’t load an image that contains several 
photos into Canoma and expect a successful 
modeling session. 

If you did capture several photographs in one 
scanned image, you may need to split, rotate, 
edit or crop your scanned photos into 
individual image files. Save them as BMP or 
JPG, approximately 800x600 resolution, which 
works out to between 100-300Kb per image. 

Modifying Photos

Even the best photographs sometimes need 
retouching. This can be especially useful when 
you’re using a single image or have historical 
photos to use for modeling purposes. You might 
need to remove scratches, fine-tune colors, or 
colorize old photos, using an image editing 
tool, such as Painter or Photoshop. Should you 
need to edit photos, remember these important 
tips: 

• Never change the aspect ratio or 
dimensions of a photo after you’ve already 
started using the image in a Canoma 
project. Canoma can’t compensate for a 
distorted photograph. 

• If you’re using more than one photograph, 
be careful to adjust color, exposure levels, 
or lighting so that the photos match after 
you’ve finished editing. 

• Avoid cropping photos. It’s better to have 
lots of photos, with varying detail than to 
try and “crop out” images of objects within 
a photo. Canoma may get confused if all 
you feed it is bits and pieces of 
photographs. 

Tip
Although most digital camera 
don’t offer extremely wide angle 
lenses, scanned photographs 
where wide angle lenses (28-
35mm) were used can introduce 
spherical distortions—where 
lines become curves. When this 
happens, precisely matching 
things in the photograph 
becomes difficult. Canoma can 
not undo these types of 
distortions. 
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• Avoid using photos with white borders or 
photos that were scanned from a book that 
include superfluous materials around the 
image you’re scanning (such as bits of text.) 
White borders are common in older 
photos and Canoma treats the border or 
extra material as part of the image to be 
modeled. For best results, remove the 
white borders or superfluous material 
before loading the image into Canoma. 

Controlling Exposure and 
Lighting

Try to use similar exposure and lighting settings 
for all the photographs of a scene or object. 
Canoma compensates for somewhat different 
lighting between photographs in fancy 
texturing mode, but it can’t make the difference 
between sunny and rainy day photographs 
disappear. 

Things to remember: 

• Control contrast by putting small light 
objects on top of dark backgrounds or 
small dark objects on top of light 
backgrounds. 

• Watch out for glare! You don’t want glare to 
bounce off of shiny parts of important 
objects, obscuring necessary texture 
details. 

Handling Camera Location

If you can, take some photographs from slightly 
above your objects. If there is a block-like 
object in the scene, it is best to show 3 sides of 
it in the photo, because that allows you to put 
more pins onto a single box. 

Make sure you see the bottom edges of objects 
or the floor in some pictures. Canoma works 
much better if you can point out some bottom 
corner or edges with pins or beads. Without 
that, wireframe bottoms might wobble around. 

Photographs from this angle give very poor results. 

This angle would be a little better, but not much. 

Three visible three bottom corners gives excellent results. 
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6  

Building 
Projects

How Canoma Works
Modeling 3D Objects

Canoma is designed to help you quickly build 
3D models. Using information you give it, 
Canoma tries to find parameters such as: 
camera location, focal length (zoom), object 
positions, object orientations, and object 
dimensions. 

To give Canoma information about how to 
construct these models, you’ll affix 3D objects 
to photograph elements, using pins, beads, 
and glue. These constrain parameters into 
taking on correct values. Refer to “Working 
with Objects” on page 73 and “Modeling 
Objects” on page 113 for some interesting 
modeling techniques.



Using 2D Source Images 

To create Canoma models, you must provide 
one or more photographs of the object(s) being 
modeled. For most projects many photographs 
are available. In general, multiple images 
provide views from different angles, making 
determination of perspective and object 
dimensions more accurate. When only one 
image is available, “on creation” options should 
be used to give Canoma additional parameter 
information. Refer to “2D Image Palette” on 
page 72, “Using the 2D Image Palette” on 
page 95, and “Adding More Detail” on page 94 
for more about using source photographs. 
Refer to “Adding an Object” on page 84 for 
more about using “on creation” options. 

Modeling from the Ground Up

Scenes are usually modeled from the ground 
up. Working from a ground plane, you place 
objects on the ground, then place objects on 
top of those, and so on. By default, you cannot 
have an object just “floating in space.” These 
restrictions make modeling a lot easier. 

In general, the default constraints are useful, 
sometimes you may have to change them: for 
example if you know an object is not sitting on 
the ground plane or if it has an arbitrary 
orientation. In those cases you can “unlock” 
some or all of the fixed parameters. Refer to 
“Freeing Necessary Parameters” on page 119 for 
more about freeing object parameters. 

Always Calculating 

Canoma is almost always “active”. Unlike a 
draw or a paint program, which only reacts 
when you have the mouse button down, 
Canoma tries to calculate decent parameter 
values, even after you let go of a pin or bead. 

Canoma tries to minimize the stress that can be 
caused by simple errors, like misplacing a pin, 
by adjusting across all objects simultaneously. A 
special Stress Display mode shows any 
disparity between how you position objects and 
how Canoma converts those instructions into 
3D representations. Refer to “Listening to the 
Canoma “Heartbeat”” on page 115 for more 
about how Canoma is always working and 
“Avoiding Model Stress” on page 92 for more 
checking how Canoma is interpreting 
information as you work. 

Before You Start
As you start to model, keep these basic 
concepts in mind.

• Model from less-detailed overview photos 
to more-detailed or close-up views. Add 
more images to supply additional texture 
detail. 

• Choose a good first picture, one that shows 
a lot of your scene. Model a few elements 
in that picture, maybe three to ten, before 
even thinking about loading additional 
images. Refer to “Taking Photographs” on 
page 65 for more information on taking 
photographs that might make modeling 
easier. 

• Start by affixing simple 3D objects to a 
photograph, like Boxes. Using a few simple 
objects helps establish perspective—the 
camera position, orientation, and focal 
length—for your scene. Refer to “Starting 

Tip
So, you’ve got your digital camera 
out and are eying your desk as a 
likely first project. Think again! 
Desktop areas are often cluttered 
with objects of varying difficulty 
and parameters. For a good first 
experience: do the Tutorials, start 
simple, then tackle more complex 
projects. 
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Simple” on page 117 for more about using 
simple objects to set parameters. 

• Use temporary objects to set perspective. 
For example, if there’s a staircase that 
needs to be modeled, try using a box for 
that element, then replace it later with a 
staircase. Refer to “Establishing 
Perspective” on page 117 for more about 
using temporary objects while modeling. 

• All objects are by default created on the 
ground plane (except for on top objects.) In 
addition, objects are by default only able to 
rotate around their vertical axis. Refer to 
“Adding an Object” on page 84 and 
“Freeing Necessary Parameters” on 
page 119 for more about object parameters. 

• Organize your project and all project 
photographs into a single directory or 
folder. Refer to “Organizing the Project 
Folder” on page 58 for more information 
about organizing your projects. 

Using the Canoma 
Workspace 
The Project Window 

In Edit mode, Canoma’s Project Window shows 
the active photograph and any wireframes of 
objects you may have created to match that 
image. In View mode, the Project Window lets 
you view the project you’re creating. 

To resize the Project Window: 

1 Move the cursor over the bottom right 
corner of the Project Window. 

2 Click and drag the window to the desired 
size. 

To move the Project Window:

• Click and drag the title bar above the 
Project Window. 

The Canoma Project Window. 
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To adjust the aspect ratio of your project 
scene: 

• Click the Size Indicator above the right 
hand corner of the project window and 
enter a new aspect ratio. 

When you render an image or animation, a 
popup menu with output file size choices is 
displayed, but any rendered image or 
animation is locked to the aspect ratio of 
your project window. 

Camera Controls 

The Camera Controls, used to view and rotate 
your project can be repositioned on the 
workspace. Refer to “Viewing Projects in 
Progress” on page 89 for how to view models in 
progress. Refer to “Using Canoma Camera 
Controls” on page 98 for complete information 
on how to use the Camera Controls. 

2D Image Palette

 The 2D Image Palette can also be repositioned 
on the workspace. Refer to “Using the 2D 
Image Palette” on page 95 for more information 
about the 2D Image Views palette. 

To move either the Camera Controls or the 
2D Image Palette: 

• Click and drag the edge of the controls or 
palette to a new position. 

Selecting Colors 

You can customize your Canoma workspace 
even more by choosing different colors for such 
things as:

• background color (choose a color that 
makes viewing textures easy, the default 
color is dark gray) 

• selected object wireframe color (the default 
color is red) 

• unselected object wireframe color (the 
default color is yellow) 

• stress wireframe color (the default color is 
white) 

• shadow color (the default color is light 
gray) 

• selected object constraint (the selected pin, 
bead, or point of glue) 

Refer to “Changing Canoma Colors” on page 56 
for more about how to customize colors in 
Canoma. 

Working with Canoma 
Projects 
A Canoma project is made up of photograph(s) 
or image(s) over which 3D objects are mapped. 
Refer to “Organizing the Project Folder” on 
page 58 for more about organizing your project. 

The first thing you need to do is launch the 
Canoma application. Once it appears, Canoma 
displays the Workspace in its default 
configuration. 

To create a Canoma project: 

1 Start Canoma. 

2 Select the opening credits canvas, select 
File menu > New, or select File menu > 
Add Image. 

Canoma supports the following 2D file 
formats: JPG, TIFF, PNG, GIF, PSD, BMP, 
and PICT. 

To open an existing 3D project: 

• Select File menu > Open Project. 
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Working with Objects 
Matching Objects to Photo 
Elements 

The goal is to make 3D objects match an 
underlying image. To accomplish that, you’ll 
create objects and pin them to elements in a 
photograph, pinning as many corners of each 
wireframe as is needed to get a reasonable 
match between the wireframe and the 
photograph. 

Model large elements around the entire 
photograph first. This establishes perspective 
(camera angle and focal length.) If you start 
modeling in great detail in one corner of a 
photograph, it’s easy to imprecisely place a pin, 
causing Canoma to estimate a wrong 
perspective. 

The Canoma coordinate system is based upon 
the following definition: 

Selecting the Correct Object

As you get ready to create objects and pin them 
to elements in a photograph, consider the 
following information about each object type. 

• Box - A box is a good object to use when 
starting a scene. Helps to determine initial 
perspective. Often useful as temporary 
“helper” objects for the purpose of 
determining perspective. With a box, four 
pins are usually enough to get started. 

Tip
Want to import and place into 
your scene a model created in 
another 3D program? 

• Create a simple Canoma 
object, to define the position 
and orientation for the 
object you are importing.

• Import, size and position the 
imported model, using the 
Canoma object for 
placement purposes.

• Delete the Canoma “helper” 
model. 

Y points up - the “height” dimension. X points right - the 
“width” dimension. Z points towards you - the “length 
dimension. 

The Box is a good choice when starting a scene. 
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• Rectangle - The Rectangle can be used 
when the photograph element you’re 
modeling is flat (no height). 

When you need to model a carpet on the 
floor, where both are modeled as 
rectangles, a big one for the floor and a 
smaller one for the carpet, select the floor 
rectangle, then create the carpet rectangle 
with Stack selected. That raises the carpet 
rectangle slightly to avoid rendering 
problems when 2 rectangles exist in the 
same plane. 

• Vertical Rectangle - The Vertical Rectangle 
can be used when the photograph element 
you’re modeling has height, but no width 
or depth. 

• Guide Line - A Guide Line is used when a 
geometric aid is required. A Guide Line 

does not show up in 3D preview or 3D file 
export formats. 

Guide Lines can be used to add “real 
world” information to your model. You can 
enter an absolute length measurement for 
a Guide Line. 

When you select Object Information for a 
Guide Line object, you’ll see two 
additional options. There is an entry box 
where you can enter the length of the line 
and a checkbox where you can have 
Canoma use the line length to calibrate 
your scene. 

You can also use the Calibration option to 
automatically calibrate your entire model 
to reflect the length you enter. If Calibrate 
is checked, the entire scene is calibrated 
according to the Guide Line length you 
enter. If Calibrate is not checked, the scene 
does not change, except to reflect any 
length setting you may have entered for 
that line. When you enter a length 
(calibration or additional measurement), 
the length of the line is locked to that 
length. In order to unlock it and have it 
become a normal guide line again, delete 
the line and create a new one from scratch. 

Refer to “Calibrating a Scene” on page 84 
for more about calibrating your picture. 

The Rectangle. 

The Vertical Rectangle. 

A Guide Line is a geometric helper. 
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You can create a Guide Line, glue it to the 
side of a box, then duplicate it to force one 
or several objects to have the same 
dimensions. For example: 

You can use a Guide Line to align objects. Create a Guide Line. Unfix all parameters. 

Glue the Guide Line to the edge of a box. Once glued, 
duplicate the Guide Line. 

Glue the duplicate Guide Line to a 2nd edge, then 
duplicate the Guide Line again. 

Glue the third Guide Line to a third side of the box. Like 
magic, you have a cube, with equal sides, thanks to the 
duplicated “yardstick.” Pin anyplace on the box and watch 
the box change size, but remain a cube. 

Create a Guide Line, then use pins or beads to fix it in 
place. 

Use edge to edge glue to glue objects to the Guide Line, 
forcing alignment. 
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You can use a Guide Line to distribute 
objects in space at equal distances, as 
might be needed in a cemetery or vineyard 
scene. 

After aligning objects to a Guide Line. 

Create a Guide Line, then use pins or beads to fix it in 
place. 

Create additional Guide Lines (selecting concentric 
duplicate). 

Glue objects to endpoints of Guide Lines. 

Equally spaced objects. 

Try It
Experiment with using a Guide 
Line as a geometrical helper. 
Load an empty, gray 600 X 400 
image as the background, then 
use a Guide Line to try and create 
a pentagon object with equal 
sides! Hint: you’ll need more 
than 5 Guide Lines. 
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• Roof and Slanted Roof - Both a plain roof 
and a slanted roof are available. 

When doing roofs, it is often handy to glue 
corners to a base box. 

Roof. 

Slanted Roof. 

Glue three points to glue a roof into place. 

If a roof was created concentric, aligned, and stacked, a 
single “drop” of glue is enough. A roof doesn’t have to fit 
exactly, but can overhand a little. Don’t use glue when this 
is the case. Put a pin on an aligned, concentric, stacked 
roof 

Watch out for common mistakes. Pinning a roof, forces the 
roofline to be flush with the building front wall. To allow 
the roofline to stick out a little, place a bead instead. 

If an aligned stacked roof starts life at the wrong 
orientation, you can always rotate it 90 degrees. 
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• Pyramid - A pyramid is fairly sensitive to 
incorrect top pin placement. 

If you can not see the top of the pyramid in 
your photograph, use a bead on one or 
more of the vertical edges, instead. 

• Truncated Pyramid - A pyramid with the 
top “cut off.” 

• Table - With a table, all four legs have the 
same dimensions and are placed 
symmetrically around the table center. 

After rotating. 

The Pyramid. 

It’s tricky to use pins when securing a pyramid at the top. 

Use beads on edges when the top of a pyramid can’t be 
exactly seen. 

A Truncated Pyramid is useful for roofs, towers, or (very) 
rough stand-ins for people. 

A Table. 
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While you are pinning the table, the legs 
may temporarily “detach” or float outside 
the tabletop. This is not a problem. Pins or 
beads can return the unruly legs to their 
proper place. 

If that should happen:

• Recreate the table and pin it. 

• Create an aligned concentric box. 

• Unfix Y to allow the box to float 
upwards. 

• Glue a top corner to the top of a table 
leg. 

• Move the bottom of the box up with a 
bead. 

• Arch - The arch can be tall and slim, short 
and squat, or thick and blocky. 

The center portion of an Arch is made up 
of two straight edges, joined by a 
semicircle. 

The shape of the Arch depends upon the 
curvature of that semicircle. Because you 
probably cannot see the exact top of the 
arched portion, place beads to help 

Table legs can temporarily “detach” or float outside the 
tabletop. 

Tables can also be used to make chairs. To create the 
backrest, create a box, unfix all parameters, glue two of 
the corners. 

An Arch can assume many sizes. 

The Arch portion of an Arch is made up of two straight 
edges, joined by a semicircle. 
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Canoma determine where the straight 
sections end and the arched portion 
begins. 

It is tempting, but not advisable, to start 
modeling some photo elements, such as 
towers, using an Arch. Better to use a 
temporary helper Box, to establish where 
the whole structure is located. Then, place 
the arch and build other objects on top of 
it. Delete the helper Box after you’ve 
finished. If you start with an Arch as your 
first object, your model may feel “wobbly”, 
because an Arch has more ways to change 
shape than a Box. 

• Stairs - A very convenient object. You 
could create them with a bunch of aligned 
boxes, glued together, but that could get 
tedious. All steps are assumed to be the 
same height. Usually a few pins (around 

four) will position them correctly. You don’t 
need to pin every step. 

If you need other types of stairs, you can 
still use aligned boxes and even make them 
all the same height by using duplicated 
Guide Lines glued to each step’s vertical 
edge. 

• Floor Rectangle - Another convenience 
object. The Floor Rectangle simply creates 
a rectangle presized to be big enough to fit 
your whole existing scene. (Otherwise, it’s 
just a normal rectangle.) Floor Rectangles 
can be really handy if you want a textured 
“ground plane.” 

Beads help determine where the straight sections end and 
the arched portion begins. 

Stairs are convenient. 

Floor Rectangles conveniently create a presized rectangle, 
big enough to fit your whole scene. 
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Objects with Editable Polyline 
Contours. 

There are three objects with editable polyline 
contours: 

• Translation Sweeps (horizontal and 
vertical varieties) - Translation Sweeps are 
powerful objects that let you approximate 
complex geometry with a few clicks. 

Translation Sweeps start life with a 
triangular contour. You can then add and 
delete points, to create a unique shape. A 
Translation Sweep must have a minimum 
of three contour points. 

With Translation Sweeps, you can 
approximate curved contours, with several 
linear pieces. Remember that the pixels 
will do most of the work, so you don’t need 
to be too precise. Approximated geometry 
works quite well. 

You can make certain sides of a Translation 
Sweep the same length. Create a Guide 
Line, unfixing all parameters to allow it to 
rotate freely and move up or down. Glue it 
to one edge of the Translation Sweep. 
Duplicate the Guide Line, or aligned 
duplicate if the other edge is not only 
supposed to have the same length, but also 

Note
The Curtain object also has 
transparency properties. From 
inside, the Curtain is visible. 
From outside, a Curtain 
disappears, allowing you to look 
through to the model! 

Horizontal Translation Sweep. 

Vertical Translation Sweep. 

Examples of Translation Sweeps, used to create interesting 
shapes, like logos, signs, or cars. 

Tip
It’s always a good idea to start 
simple. Don’t use a Translation 
Sweep as the first object in a 
scene. 
81 Canoma



the same orientation as the first Guide 
Line. Glue corners of the cloned Guide 
Line to the second contour edge. 

For Horizontal Translation Sweeps (where 
the contour is vertical, but the extrusion 
axis is horizontal), the two lower contour 
points which sit on the floor level are fixed 
at Y=0. This allows them to stay on the 
floor, rather than float about. These fixed 
contour points can be changed to free 
parameters. If these fixed contour points 
are deleted through contour editing, 
remember that replacement points have 
free parameters and you will need to 
manually fix the object once again to the 
floor. You can’t directly “refix” parameters, 
but you can use Guide Lines and glue to 
bring Translation Sweep corners to specific 
planes, lines, or locations. 

• Polygon (horizontal and vertical varieties) 
- polygons are very similar to Translation 
Sweeps. They are also powerful objects 
that let you approximate complex geometry 
with a few clicks. 

Use copied Guide Lines to make sides equal in length. 

Use aligned duplicated Guide Lines if the sides are equal 
in length and have the same orientation. 

Polygons (horizontal). 

Polygons (vertical). 

Examples of Polygons. 

Tip
It’s always a good idea to start 
simple. Don’t use a Polygon as 
the first object in a scene. 
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Polygons start life with a triangular 
contour. You can then add and delete 
points, to create a unique shape. A Polygon 
must have a minimum of three contour 
points. 

With Polygons, you can approximate 
curved contours, with several linear pieces. 
Remember that the pixels will do most of 
the work, so you don’t need to be too 
precise. Approximated geometry works 
quite well. As with Translation Sweeps, you 
can use can make certain sides of a Polygon 
the same length, with the help of some 
glue and Guide Lines. 

For vertical Polygons, the two lower 
contour points which sit on the floor level 
are fixed at z=0. This allows them to stay on 
the floor, rather than float about. These 
fixed contour points can be changed to free 
parameters. If these fixed contour points 
are deleted through contour editing, 
remember that replacement points have 
free parameters and you will need to 
manually fix the object once again to the 
floor. You can’t directly “refix” parameters, 
but you can use Guide Lines and glue to 
bring Polygon corners to specific planes, 
lines, or locations. 

• Curtain - A special object to allow better 
modeling for walls in rooms. The curtain is 
only visible from one side. You can actually 

look right through it from the other 
direction. 

You can create a curtain which represents a 
wall in a room (or create several.) As seen 
from inside the room, the curtain is visible 
and textured. When you navigate outside 
the room in 3D Preview mode, the curtain 
walls disappear, allowing you to look right 
inside the room (like a television studio 
set.) Had you used rectangles for the walls, 
the view from the outside would still show 
the rectangle obscuring the room’s 
interior. 

Tip
Use Polygons for “cut-out” trees 
and people. Of course, they’ll be 
quite thin. Alternately, you can 
completely mask obstructions by 
using the Alpha channel in your 
source images. Refer to “Using 
the Alpha Channel” on page 106 
for more about using the Alpha 
channel. 

A Curtain. 

Tip
It’s always a good idea to start 
simple. Don’t use a Curtain as the 
first object in a scene. 

From outside, curtains are invisible! 
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You can add and delete contour points 
with the curtain like you can in the 
Translation Sweep and the Polygon. A 
curtain must have a minimum of three 
contour points. 

Calibrating a Scene 

You can use the Calibrate option to 
automatically calibrate your entire picture to 
reflect the Guide Line length you enter. 

Typically, you use calibration for the first length 
that you enter, in order to establish overall scale 
for the scene. This scale is used if a scene is to 
be exported to VRML. As more measurements 
for other line objects are added, leave the 
calibration box unchecked, since you want all 
measurements respected at the same time, i.e., 
have them treated like constraints, that involve 
solving for scene parameters. 

To calibrate a scene: 

1 Select or create a Guide Line object. 

2 Click the Object Information button to 
display the Object Attributes for the Guide 
Line. 

3 Enter a numeric value for Guide Line 
length or use the scaling slider to set that 
dimension. 

4 Select Calibrate. A checkmark is displayed 
when Calibrate is selected. 

Only one Calibration setting is allowed. 
You can Calibrate anytime. When you click 
Calibrate, any prior Calibration setting is 
replaced. 

Adding an Object 
Setting Selection Based Options 

At the time that you create an object, 
orientation and alignment options are available. 
Selecting these options at creation provides 
Canoma with important information that can 
help you create more accurate models. 
Selection based options are available when an 
object is selected, since they define the 
parameters of the object to be created in 
relation to the selected object. 

• Stack creates an object directly on top of 
the currently selected object. Refer to 
“Stacking Objects” on page 86 for more 
information about creating objects on top 
of other objects. 

• Align Rotation creates an object with a 
rotation parameter the same as the selected 
object. 

• Concentric creates an object with the same 
center as the currently selected object. 

For example, say you want to model a 
tower. The base is modeled using a box, 
then you want to place a pyramid on top of 
the box to model a spire. The top of the 
pyramid should be exactly above the center 
of the box—or concentric to it. In general, 
concentric means "objects having the same 
center." Canoma stretches the definition of 
concentric a little. In Canoma, concentric 
means "has the same center in Z and X", 

Note
The Floor Rectangle object also 
has some transparency 
properties. From above, it is solid. 
From below, it’s transparent. 

Note
Consider calibrating a Canoma 
scene an advanced option. Be 
aware that when you force a 
numeric calibration, it affects 
your entire project. 
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not in Y. The Concentric option is very 
handy for building linear structures and 
for placing roofs onto buildings. 

To add an object: 

1 Click the Creation tab to display the 
Canoma objects. 

2 Set object properties. 

3 Click the desired object. If you can’t see 
the object you want, use the slider to view 
more objects. 

A wireframe of the selected object is 
displayed on top of your photograph. 

Selecting an Object 
When an object is selected, its wireframe turns 
red. Refer to “Changing Canoma Colors” on 
page 56 for more about changing wireframe 
colors. 

To select an object: 

• As you move the cursor over an object in 
the Project Window (or close to the 
wireframe), its yellow wireframe is 
highlighted (thickened.) Click down to 
select it. 

• Click the pop-up object menu below the 
Project Window. Keeping the mouse 
button depressed, scroll through the list 
and release the mouse button when the 
correct object is highlighted. 

Deleting an Object 
To delete an object: 

1 Select the object that you want to delete. 

2 Press the delete key, or Right/Opt-click the 
object you want to delete, then select 
Delete Selected.

Checking Object 
Information 
You can inspect object information and make 
some changes to objects, using the Object 
Information dialog. 

Object information includes: 

• Name (editable) 

• Object Type (not editable) 

• Guide Line object Dimensions, Scaling, 
and Calibration options (editable) 

• Selection Based Options (options selected 
at time of creation) - Concentric, Stack, 
Align (not editable) 

• Alignment options:

Object s. 

Set Selection Based Options. 
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• Rotate by 90 degrees (available) 

• Unfix Y parameter (available once) 

• Unfix all parameters (available once) 

• Unfix orientations (available once) 

To review or change object information:

1 Select an object. 

2 Click the object information button or 
select Edit menu > Get Information. 

The Object Information dialog is 
displayed. 

Stacking Objects 
Usually, scenes are modeled from the ground 
up. Working from a ground plane, you place 
objects on the ground, then place objects on 
top of those, and so on. Refer to “Adding an 
Object” on page 84 for more about object 
selection options. 

When you create an object on top of another 
object, its origin’s z-coordinate is not free, but 
is bound to the height of its base object. 

To stack an object on top of another: 

1 Make sure the object upon which you want 
to place another object is selected, i.e. 
make sure that it is red. 

If the desired wireframe is yellow, click 
somewhere inside the correct wireframe 
object to select it. 

2 Click the Creation tab. 

The object information button. 

The Object Information dialog. 

Select the object on top of which you plan to build. 
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3 Choose an object and select Stack. 4 Pin the on top box to its underlying object. 

Duplicating Objects 
Use duplicate whenever you are sure two 
objects have the same dimensions. It reduces 
the number of pins you need to place and at the 
same time makes the 3D project more precise. 

Fewer pins are required for pinning a 
duplicated object, because some dimensions 
are known to Canoma from the first object. 

To duplicate an object: 

1 Select the existing object that you want to 
duplicate. 

2 Choose Edit menu > Duplicate. 

Select Stack. 

Choose an object. 

After pinning 
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An object with the same dimensions as the 
original is created. 

If you are sure that both the original and the 
duplicate have the same orientation, use the 
Aligned Duplicate option. This will result in 
more precise models. 

To create an aligned duplicate:

1 Select the existing object that you want to 
duplicate. 

2 Select Edit menu > Aligned Duplicate or 
press Shift/Ctrl + D. 

An object with the same dimensions as and 
aligned to the original is created. 

To roughly align an object:

1 Canoma creates objects at default positions 
and orientations. If there is a big 
discrepancy between the initial perspective 
for a new object and the picture’s 
perspective, use the Camera controls to 
roughly align the two before starting to 
place pins. Refer to “Using Canoma 
Camera Controls” on page 98 for more 
about using the Camera. 

Pinning Objects 
Once an object is created, it then can be 
pinned to an underlying photograph. Pinning a 
wireframe to a picture feels like pinning the 
corners of a springy wireframe to a tackboard, 
using push-pins. Refer to “Deleting All 
Constraints” on page 90 for how to delete all 
constraints (pins/beads/glue) for a selection. 

To pin an object: 

• Click and drag each corner of the object to 
the corners of the element you are 
modeling in the photograph. 

A triangle appears when the cursor is over 
a corner of the wireframe. If you make a 
mistake, you can always Undo (Ctrl-Z.) 
Refer to “Undoing Operations” on page 59. 
Refer to “Deleting All Constraints” on 
page 90 for how to delete all constraints 
(pins/beads/glue.)

To delete a pin:

• Right/Opt-click the pin you want to delete, 
then select Delete Pin. 

Use duplicate when objects have the same dimensions 

Drag wireframe corners to the corners of each element 
being modeled. 
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Viewing Projects in 
Progress 
To look at a 3D project:

1 Click and drag the trackball controller. 
You’ll see a shaded 3-dimensional box with 
the correct dimensions. As you drag the 
trackball, the box rotates. 

Refer to “Using Canoma Camera Controls” 
on page 98 for more information about 
using the camera controls to view your 3D 
project. 

Using Beads 
Defining Edges

Close-up views often have the problem that you 
cannot see a whole object you previously 
modeled. You can use a second (of three) 
techniques to position objects. Pins are for 
corners, but beads are for edges (and glue is 

used to align objects.) Refer to “Deleting All 
Constraints” on page 90 for how to delete all 
constraints (pins/beads/glue) for a selection. 

To add a bead to an object: 

1 Move the cursor over any edge (rather than 
corner) of an object.

A little disk appears. 

2 Click to create a bead. 

3 Drag a bead to position an object edge. 

To delete a bead:

• Right/Opt-click the pin you want to delete, 
then select Delete Bead. 

Drag the trackball to rotate the project. 
Use beads to position an object’s edges. 

Tip
If a bead does not stay exactly on 
an edge, your model is probably 
stressed. You may have pinned a 
corner of an object incorrectly. 
See “Avoiding Model Stress” on 
page 92 for more about 
controlling stress in your models. 
89 Canoma



Using Glue 
Gluing Objects Together 

Use glue to align objects precisely. When you 
create an object aligned with another object, 
Canoma only has to find a single, common 
rotation angle, instead of figuring out two 
vertical axis rotations. 

With Canoma, you can use these gluing 
techniques: 

• Glue point to point 

• Glue point to edge 

• Glue edge to corner or to Guide Line.

Refer to “Using Glue to Align Objects” on 
page 121 for more about gluing techniques. 
Refer to “Deleting All Constraints” on page 90 
for how to delete all constraints (pins/beads/
glue) for a selection. 

To add glue: 

1 Hold down the Cmd/Ctrl key and click on 
the corner of the object that you want to 
align with another object

2 While continuing to hold down the Cmd/
Ctrl key, drag that corner over the 
appropriate corner of the object with 
which you are trying to align the first. 

A little yellow pin is visual feedback that 
you are gluing two object together. 

3 Let go of both the Cmd/Ctrl key and the 
mouse button. 

To delete glue:

• Right/Opt-click the glue you want to 
delete, then select Delete Glue. 

Deleting All Constraints
To delete all constraints (pins/beads/glue) of 
a selected object:

• Right/Option-click the pin you want to 
delete, then select Delete Constraints of 
Selection. 

To delete all constraints (pins/beads/glue) of 
a selected object in the current image:

• Right/Option-click the pin you want to 
delete, then select Delete Constraints of 
Selection in this Image. 

Yellow pins tell you that one object is being glued to 
another. 
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Using Solo Mode 
As you add more objects, some with objects on 
top of them, the display can get cluttered. 
Using Solo Mode reduces confusion. When you 
use Solo Mode, you can see clearly the 
wireframe for the current object, but all other 
wireframes are displayed very faintly. This can 
really help when there are many objects in your 
scene. 

To use Solo Mode: 

• Click the Solo Mode button to switch off 
all objects except the currently selected, or 
select View menu > Show only Selection. 

Unless you’ve changed colors, the selected 
wireframe is red. 

To switch back from Solo Mode to normal 
editing: 

• Click the Solo Mode button again, or 
reselect View menu > Show only 
Selection. 

Even while you are in Solo Mode, when you 
move the cursor over other areas of the 
photograph, existing, but currently hidden 
objects, temporarily show up outlined in yellow. 

Solo Mode lets you see where objects are 
located and also lets you quickly select one for 
further work, without having to switch in and 
out of Solo Mode. 

Using Shadows 
Canoma can cast shadows from objects. 
Shadows can land on other objects or on the 
ground plane. 

Shadows help you see when an object is on top 
of something else (the shadow shows up) or if 
it’s sitting at the same level (no shadow.) The 
distance of a shadow to an object can help you 
judge how high the object is above another 
object or above the ground plane. Shadows can 
act as subtle cues about the 3rd dimension. 
Shadows are turned Off by default 

The Solo Mode button 

Use Solo Mode to reduce confusion. 
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To turn shadows On:

• Click the Show Shadows button, or select 
View menu > Show Shadows.  

To turn shadows Off: 

• Click the Show Shadows button or select 
View menu > Show Shadows. 

Displaying the 
Background Image 
In 3D Preview Mode, you can opt to display the 
photograph as a background image. This can 
make it easier to see textured models in 
relationship to surrounding pixels. Displaying 
the background image is also useful when you 
want to quickly edit textures. Refer to “Working 
with Texture” on page 93 for more about editing 
textures. The background image is turned Off 
by default 

To turn background image On: 

1 Generate textures, then switch to 3D 
Preview mode. 

2 Click the Show Background Image button 
or select View menu > Show Background 
Image to displays your photograph, along 
with your textured models. 

To turn background image Off: 

• Click the Show Background Image button 
or select View menu > Show Background 
Image. 

Avoiding Model Stress 
It is important not to "mislead" Canoma. For 
example, when you tell Canoma that an object 
has the same orientation as another, but it 
really does not, Canoma can yield inaccurate 
results. When that happens, the model is 
"stressed" or unnatural. Refer to “Monitoring 
Stress in the Model” on page 120 and 
“Listening to the Canoma “Heartbeat”” on 
page 115 for more about controlling stress in 
Canoma models. 

The Stress Display can help pinpoint exactly 
which pins or beads feel the most "wrong" to 
Canoma (might have been placed wrong by 
accident or as the result of an incorrect guess.) 
When too much stress is present, it’s best to 
delete any potentially inaccurate pins or beads. 
The Stress Display is turned Off by default. 

Click the Show Shadows button. 

Show Shadows

Click the Show Background Image button. 

Show Background Image
92 Building Projects 



To turn stress display On: 

1 Click the Show Stress Display button, or 
select View menu > Show Stress Display. 

The Project Window changes to display 
two sets of objects. One set is the 
wireframes you pinned. The other set—the 
gray wireframes—represent 3D objects 
that Canoma constructed according to 
your pin and bead “instructions.” If your 
wireframes look skewed in comparison, 
simply repair the offending corners or 
adjust any wayward beads. 

To turn stress display Off: 

• Click the Show Stress Display button or 
select View menu > Show Stress Display. 

Working with Texture 
Adding texture is the process of having 
Canoma map the pixels of an underlying image 
to the faces of 3D objects. 

Canoma offers two types of texturing: 

• Quick Texture - fast, but can leave gaps 
where photographic information is 
missing. 

• Quality Texture - compensates for 
brightness differences between 
photographs that can show up as seams. 
Fills in white gaps for which there is no 

available information, by filling the holes 
with surrounding pixels. Quality texturing 
takes longer, but it looks better. 

Adding Textures 

To add Quick Texture to a model: 

1 Select Texture menu > Quick Resolution 
to set the desired resolution. 

2 Click the Quick Texture button. 

To add Quality Texture to a model: 

1 Select Texture menu > Quality Resolution 
to set the desired resolution. 

A resolution setting of 1:1 uses all the 
pixels in your source image. It gives you 
the highest definition, but it will take 
longer to complete the application of 
texture. 

2 Click the Quality Texture button. 

3 Use the arrow to popup a menu of 
resolution choices. 

Stealing Textures

Sometimes you only have one photograph. 
When that’s the case, there is no pixel 
information for the back of objects in the 
model you create. There’s a quick way to steal 
textures from a textured side and apply it to the 
side that has no texture information. There are 
times when this can help complete the illusion 
of a fully textured model. 

Click the Stress Display button. 

Show Stress Display

Quick (the rabbit) and Quality (the turtle) Texture buttons 
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To apply stolen textures to untextured 
object panes: 

• Select Texture menu > Mirror Textures. 

The next time you use Quick or Quality 
Texture, Canoma automatically calculates 
opposing side information and steals 
textures for objects that would otherwise 
have no texture information. 

Canoma has a good idea of where it can steal 
textures from for most objects. Setting Texture 
menu > Mirror Textures to On causes Canoma 
to steal all possible textures for all untextured 
areas in your scene. Sometimes, however, 
Canoma can’t find a good place from which to 
steal a texture, even though it might be obvious 
to you where you’d like the stealing to take 
place. For example, in Translation Sweep 
objects, corresponding faces are not predefined 
by Canoma. 

When “where to steal” is not defined, you can 
use texture editing to steal it yourself! Refer to 
“Retouching or Editing Textures in 2D” on 
page 103 for more about editing textures with a 
2D pixel editing program, like Painter or 
Photoshop. 

To manually steal textures for untextured 
object panes: 

1 Use the Texture Brush to click the pane of 
the object that displays the texture that you 
want to “steal.” 

2 Once your 2D pixel editing program is 
open, quickly copy the texture and return 
to Canoma without saving. 

3 Use the Texture Brush to click the pane of 
the object where you want the “stolen” 
texture to be applied. 

4 Once your 2D pixel editing program is 
open, paste the copied texture, rescale the 
source pixels if necessary, save your edits, 
and return to Canoma. You might also 
need to flip the source pixels horizontally 
or vertically, before saving. 

Adding More Detail
One photograph can’t show all object sides. To 
include texture information for areas that are 
not textured in the initial photograph, you can 
add more photos to your project. For example, 
if you need better textures for the front of a 
specific building or need to fill in texture for 
the back of a product box, you can add more 
detailed information with additional photos. 

Imagine doing some architectural photographs: 

• first create a project using an aerial 
photograph, 

• next add detail from close-up shots taken 
at ground level. 

Close-up views often have the problem that you 
cannot see a whole object you previously 
modeled. As you position the wireframe, 
remember: pins are for corners that you can 
see, beads are for edges or for when you cannot 
easily see the whole object, and glue is for 
aligning objects. 
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Using the 2D Image Palette 

A thumbnail of the currently selected 
photograph is displayed on the 2D Image 
Palette. The 2D Image Palette opens downward 
to reveal a tray where you can access all the 
photographs in your project. 

To add an image: 

• Choose File > Add Image or click the 2D 
Image Views add button. 

To select an image: 

1 Click and drag the 2D Image Palette 
drawer handle downward to see more 
photographs. 

The scrollbar at the side of the palette lets 
you scroll through all of your images. 

2 Click a thumbnail in the palette to select it 
as the active photograph or use the 
selection arrows in the top right corner to 
move through the list of photos. A yellow 
border around an image thumbnail 
indicates that the image is currently 
selected. 

To delete an image: 

1 Click the 2D Image Palette drawer handle 
to see a tray of all the photographs in your 
project. 

2 Click a thumbnail in the palette to select it 
as the active photograph. 

3 Click the - button or press the delete key to 
remove the image from the Image Views 
palette. 

The 2D Image Palette shows the currently active 
photograph. Click the drawer handle to open a tray of all 
the images in your project. 

Tip
Always roughly align new 
photographs with your model, 
before starting to pin. 

Drag the scrollbar to scroll through images. 
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To set the maximum texture resolution: 

1 Select Texture menu > Resolution Max.

2 Choose a resolution size from the popup 
menu. 

Tip
Setting the Maximum Texture 
Resolution can be handy, since 
very high resolution texture 
images can consume large 
amounts of memory. 
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Viewing
Models

Positioning the View of 
Your Model 
When you position a view, you’re affecting the 
position and orientation of a camera, not the 
scene. The scale and position of objects 
remains constant; only your view of the model 
changes. 

Using the camera controls while in Edit mode 
switches the application to View mode. What 
you see in View mode is either flat shaded or 
textured (if you have applied textures.) While 
in View mode, you can also use the Pan tool 
inside the Project Window to move the image. 

Canoma has three sets of controls for 
positioning your view of the model: 

• a Trackball, which is useful for small 
objects directly in front of the 
photographer

• the Camera Cross controls 



• in-view navigation controls, which are 
useful for moving around in large 
environments like interiors or city scenes. 

The Trackball lets you adjust the position of the 
camera, as well as its orientation. Use the 
Trackball to rotate your model. 

The Camera Cross controls let you change the 
position of the camera along X, Y, and Z axes. 

Using Canoma Camera 
Controls 
Using the Trackball

The Trackball lets you rotate the camera around 
its origin point. The Trackball doesn’t rotate the 
model, it just changes the camera’s location 
(Offset) and orientation (Rotation) relative to 
your model. In Canoma, coordinates are 
figured in the following way: 

To move the camera using the Camera 
Trackball:

• Drag the mouse over the Camera Trackball 
control. The view of your model moves in 
the direction you drag. 

Using the Cross Controls 

Camera Cross controls let you move the view of 
your model along specific axes. When you’re 
using these controls, the view does not tilt or 
rotate from its original position. It only moves 
up, down, back, or forward.

Use the Trackball to rotate your model. 

The Camera Cross controls change the position of the 
camera along X, Y, and Z axes. 

The Canoma X, Y, and Z axes. 
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There are three Camera Cross controls: 

X-Y Cross

The X-Y Cross provides control for horizontal 
and vertical motion. The sphere at the center of 
the cross lets you move the camera in both the 
X and Y axis. 

This control affects your camera’s position 
(Offset) only, not its orientation (Rotation.) 

X-Z Cross

The X-Z Cross provides control for horizontal 
and depth motion. The sphere at the center of 
the cross lets you move the camera in both the 
X and Z axis. 

This control affects your camera’s position 
(Offset) only, not its orientation (Rotation.) 

Y-Z Cross

The Y-Z Cross provides control for vertical and 
depth motion. The sphere at the center of the 
cross lets you move the camera in both the Y 
and X axis. 

This control affects your camera’s position 
(Offset) only, not its orientation (Rotation.) 

To move the camera in two axes at once:

• Drag the sphere at the center of one of the 
Camera Cross controls. The cursor 
becomes a four-way arrow. 

The motion of your mouse determines the 
direction of the camera movement:

X-Y Cross: moving up, down, left, and to 
the right, moves the camera up, down, left, 
and to the right.

X-Z Cross: moving up, down, left, and 
right moves the camera forward, backward, 
left, and to the right. 

Y-Z Cross: moving up, down, left, and right 
moves the camera up, down, forward, and 
back. 

Using the In-View Navigation 
Controls 

The In-View Navigation Controls are right 
inside the Project Window and are available in 
3D Preview Mode. These controls are useful for 
moving around in large environments like 
interiors or city scenes. 

Using the In-View Navigation Controls feels 
like driving a car into your model, with forward 
and reverse gears. If you press the Ctrl key 
while you click-drag inside the project window, 
you can slide up, down, left and right. Either 

Use these controls to move the camera along the Y axis. 

Use these controls to move the camera along the X axes. 

Use these controls to move the camera along the Z axis. 
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way, the speed at which you move depends 
upon how far you move the mouse from the 
point where you originally clicked down. 

To use the In-View Navigation Controls: 

• Click inside the project window and drag 
up to move straight forward in your scene. 

• Click inside the project window and drag 
down to move straight backward in your 
scene. 

• Click inside the project window and drag 
left to turn left in your scene. 

• Click inside the project window and drag 
right to turn right in your scene. 

• Ctrl-click inside the project window and 
drag up to move straight up in your scene. 

• Ctrl-click inside the project window and 
drag down to move straight down in your 
scene. 

• Ctrl-click inside the project window and 
drag left to slide left in your scene. 

• Ctrl-click inside the project window and 
drag right to slide right in your scene. 

Banking Control 

The Banking control sphere rolls your Camera, 
creating the effect of a tilted horizon. 

To bank the camera: 

• Click the Bank control and drag right or 
left.

Field of View 

The Field of View control sphere acts like a 
wide-angle lens control. The higher the setting, 
the wider the field of view for your lens. 
Canoma’s Field of View control automatically 
adjusts the distance, so that objects in the 
center stay about the same size. 

To increase/decrease the camera’s field of 
view: 

• Click the Field of View control and drag up 
or down.

Tip
To get a predictable feel for the 
In-View Navigation Controls, 
make the Project Window small, 
so that the program draws faster 
and the motion is smoother. 

The Banking Control. 

The Field of View Control. 
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Zooming and Panning 
The more accurately you pin objects, the more 
accurately Canoma can figure things like: 
camera location, focal length (zoom), object 
positions, object orientations, and object 
dimensions. 

Zooming

It is usually helpful to zoom in on what you’re 
pinning, to improve accuracy. In Canoma, there 
is a difference between moving the camera and 
using the Zoom tools. 

When you move the Camera, you’re moving in 
3D space. When you use the Pan and Zoom 
tools, you’re transforming a 2D projection of 
your 3D model. When you use the Zoom tool, 
you are essentially making the 2D projection 
larger or smaller, your camera position in 3D 
space does not change. 

To Zoom in:

1 Click the Zoom tool in the Toolbar. 

2 Click inside the Project Window. 

Canoma scales the 2D projection of your 
model larger, creating the illusion of 
zooming in. The place in the Project 
Window where you clicked becomes the 
center around which the image is enlarged. 
(Remember, your 3D camera position 
remains unchanged.) 

You can also right-click (Win)/option-click 
(Mac), then drag a rectangle to zoom into a 
specific area. 

To zoom out: 

1 Click the Zoom tool in the Toolbar. 

2 Press and hold the Opt/Alt key. 

3 Click inside the Project Window. 

Canoma scales the 2D projection of your 
model smaller, creating the illusion of 
zooming out. 

To zoom into a specific area: 

1 Click the Zoom tool in the Toolbar. 

2 Press and hold the mouse button, as you 
drag a marquee around an area of your 
scene. 

Canoma centers on the marquee and scales 
the 2D projection of your model so that the 
area in the marquee fits your Project 
Window. 

To reset to non-zoomed: 

• Double-click inside the Project Window to 
reset to a non-zoomed view. 

Panning

Panning works like zooming. When you use the 
Panning tool, you are moving a 2D projection 
of your model right and left, up and down in 
front of the camera. Your camera position in 3D 
space does not change. 

The Zoom tool. 

Tips
You can always inspect progress 
in 3D preview mode.
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To pan around your model: 

1 Click the Pan tool in the Toolbar. 

2 Press and hold the mouse button, as you 
drag the Pan cursor inside the Project 
Window, in the direction you want your 
model to move. 

Resetting the Viewpoint 
At anytime, you can reset your viewpoint to 
match that of an underlying photograph. 

To reset the camera: 

1 Open the 2D Image Views palette to 
display the 2D Images in your project. 

2 Click on a desired thumbnail in the 2D 
Image Views palette to reset the camera to 
the viewpoint of that photo (available in 
both Wireframe and 3D Preview modes.

 

The Pan tool. 

Photographs in your Canoma project are displayed in the 
2D Images Views palette. Click on the bottom of the palette 
to open it, then click on the desired photograph to reset the 
camera to the viewpoint of that photo. 

Tip
Resetting the camera can be 
handy, especially after you zoom 
in or when you want to edit a 
wireframe for a different photo.
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8  

Editing 
Textures 

Retouching or Editing 
Textures in 2D
With Canoma, you can edit the texture on a 
3D object, using a 2D pixel editing tool, like 
Painter or Photoshop. After you edit the image 
in 2D “head on” view, Canoma automatically 
displays the results of your edits, in proper 
perspective. You can then output a 3D model 
or render a 2D image that reflects your 
changes. 

Each time you edit an area, Canoma saves file 
of the resulting image in a subfolder, inside 
the main project folder. If you create a 
composite (layered) file during editing, be sure 
to save a version of that file in another 
location, in case you need to do any re-editing. 



To edit textures:

1 Click the View button to switch to 3D 
Preview mode. 

2 Click the Texture Brush in the Toolbar. 

3 Click the face of the object, where you 
want to make changes. Canoma opens the 
2D editing program, with the area you 
selected ready for editing. You can now edit 
in “head on” view. 

4 Complete any edits you want to make to 
the image—add text like “This apartment 
for rent.”, retouch something, or change 
colors. 

5 Save your edit. Chose the file type (JPG, 
TIFF, BMP, or PIC) that is saved when you 
edit textures. Refer to “Choosing a 2D 
Image Editing Application and Image 
Format” on page 55 for more about 
selecting a default file format. 

 

6 Click back inside Canoma’s program 
window. The edited textures are displayed 
in proper 3D perspective. 

Editing for 2D Renders

Canoma’s Show Background Image is a simple 
way to edit perspective images. Imagine that 
you have to create a billboard or an 
advertisement on a vehicle, such as a bus or a 

The results of your edit is shown in 3D perspective. 

Texture Brush 

Note
If you have not chosen a 2D pixel 
editing program, such as Painter 
or Photoshop, Canoma asks you 
to choose one.

Double-click a 
side

Use the Texture 
Brush

Canoma shows 
your edits in 3D!

Change texture 
“head-on” in a 2D 
program

Tip
If you create a layered file while 
editing, you might want to save a 
copy of the layered file to a 
backup directory (using Save As.) 
Flatten the image. Save the 
flattened version under the same 
filename as Canoma created 
when your 2D editing program 
was opened. 

Note
Always maintain the same aspect 
ratio when editing textures on an 
photograph that has been 
modeled. You can change image 
resolution, but not the aspect 
ratio. Being able to change the 
resolution of particular portions 
of a Canoma model can be very 
useful. For example, you might 
want to increase the resolution to 
add readable text.
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house. The source you have available is a 
photograph of the object on which the ad is 
supposed to be placed. Usually, this is a 
perspective photograph (i.e. not head on). It 
might contain some context, like a surrounding 
freeway or other buildings. 

To edit texture for a 2D render: 

1 Load a photo into Canoma and quickly pin 
a box to where you want to edit texture. 

2 Click the Quality Texture button, selecting 
a high resolution setting. 

3 Click View to see the textured box. 

4 Click the Show Background Image button 
to displays your photograph in the 
background, along with your textured 3D 
model. 

5 Click the Texture Brush in the Toolbar. 

6 Click the face of the object, where you 
want to make changes. Canoma opens the 
2D editing program, with the area you 
selected ready for editing. You can now edit 
in “head on” view. 

7 Complete any edits you want to make to 
the image—add text like “This apartment 
for rent.”, retouch something, or change 
colors. 

8 Save your edit. Chose the file type (JPG, 
TIFF, BMP, or PIC) that is saved when you 
edit textures. Refer to “Choosing a 2D 
Image Editing Application and Image 
Format” on page 55 for more about 
selecting a default file format. 

Original image, loaded into Canoma. 

Click the Show Background Image button. 

Show Background Image

Texture Brush 

Note
If you have not chosen a 2D pixel 
editing program, such as Painter 
or Photoshop, Canoma asks you 
to choose one.

Tip
If you create a layered file while 
editing, you might want to save a 
copy of the layered file to a 
backup directory (using Save As.) 
Flatten the image. Save the 
flattened version under the same 
filename as Canoma created 
when your 2D editing program 
was opened. 
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9 Click back inside Canoma’s program 
window. The edited textures are displayed 
in proper 3D perspective. 

10 Render the image. 

Using the Alpha Channel
Every image contains a number of channels 
that store data about the makeup of the picture. 
For instance, channels can contain masks, 
colors, or bump information. 

The alpha channel of an image is like a 
grayscale map that accompanies an image. It is 
primarily used as a “mask.” Areas in the alpha 
channel that are white are ignored by the 
program as it computes the picture and areas 
that are black are recognized and computed 
(appearing opaque). 

The most common use for alpha channels in 
Canoma is to mask out small obstructions like 
light poles, people, cars, or trees. When alpha 
channel information is used, Canoma does not 
use pixels from masked out regions in the 
source photograph. Instead, it tries to find 
another photograph that shows the same area 
of the object and gets the pixels from there. If 
no other photograph is available you can use 
Quality texture to fill in missing pixels with a 
“washed out” version of surrounding pixels. 
With Quick texture, you see the masked area as 
white when no other photograph is available to 
fill in the pixels. 

To use alpha channel information:

• Select Texture menu > Enable Alpha 
Channels. 

Note
Always maintain the same aspect 
ratio when editing textures on an 
photograph that has been 
modeled. You can change image 
resolution, but not the aspect 
ratio. Being able to change the 
resolution of particular portions 
of a Canoma model can be very 
useful. For example, you might 
want to increase the resolution to 
add readable text.

After editing textures in Canoma. 

A 2D image without alpha channel information. 
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Alpha channel information is added. Black pixels are 
masked out 

What displays when modeling is done with Quality 
texturing. 
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9  

Creating
Animations

How Animation Works in 
Canoma 
To create an animation, first complete a 3D 
model, then view it—recording keyframes to 
illustrate the motion of the camera. Canoma 
creates a motion path from your recorded 
keyframes and generates an animation. 

The steps to creating an animation are as 
follows:

• Create the model. 

• Decide how the camera should move in 
order to view the model. 

• While viewing the model, create key 
frames, which indicate how the camera 
position or orientation has changed. 

• Review the animation, using the 
Animation Preview Controls. 

• Render the animation as a QuickTime 
movie or as a set of frames. 



Creating an Animation
Canoma’s animation tools are designed to help 
you quickly and easily animate the process of 
viewing your 3D model. When you animate the 
camera, you’re changing the view of your model 
over the course of the animation. Since you’re 
in 3D space, you can move the camera to any 
position in the model. You can have your 
camera move around the model, zoom into it, 
or even fly over it. It is not designed to be a 
complete 3D animation environment. For more 
precise control over animation parameters, you 
can use MetaCreations’s other 3D programs. 

You can create Canoma animations of any 
length; however, it’s easier to create relatively 
short animations. If necessary, you can use a 
movie-editing program to splice animation 
clips together. 

Using the Animation Controls 

The Animation Controls, located on the 
Animation Tab at the bottom of the screen are 
the tools you’ll use to create animations. They 
contain controls for adding or deleting 
keyframes, and for previewing animations. 

Creating Keyframes 

To add a keyframe: 

1 Click the Animation tab to display the 
Canoma Animation Controls. 

2 Click the Add Keyframe button (or click 
inside an empty slot in the Keyframe Strip) 
to add the current view of your model as a 
keyframe in your animation. 

To delete a keyframe: 

1 Click a keyframe to select it. 

2 Click the Delete Keyframe button or press 
the delete key to delete a keyframe from 
the animation. 

Setting Animation Options

You can set how long your animation plays, or 
the duration. 

Click the Animation tab to display the Animation 
Controls. 

Click the Add Keyframe button to add the current camera 
view of your model as a keyframe in your animation. 

Tip
Use the scroll bar to scroll 
through the frames of your 
animation. 

Click the Delete Keyframe button to delete the selected 
keyframe in your animation. 

Tip
You can hold down the Option 
key and click on the Delete 
Keyframe button to delete all 
keyframes in the animation. 
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To set how long the animation plays: 

• Double-click the Duration display, then 
enter a time, in seconds. 

You can set your animation to play 
continuously, looping back to the beginning 
when it reaches the last frame. 

To set an animation to loop:

• Select the Loop option. A checkmark 
means that Loop has been selected. 

Previewing an Animation 
The Animation Preview Controls let you 
preview the frames in your animation. 

To play an animation: 

• Click the Play/Pause button to start playing 
your animation. 

To pause/resume an animation: 

1 Click the Play/Pause button to pause your 
animation. 

2 Click the Play/Pause button again to 
resume playing. 

To stop an animation: 

• Click the Stop button.  

To advance to the next keyframe in your 
animation: 

• Press the Next button. 

To advance to the final keyframe in your 
animation: 

• Hold down the Alt/Option key and press 
the Next button.

To return to the previous keyframe in your 
animation: 

• Press the Prev button. 

The Animation Preview Controls. 

The Play/Pause button. 

The Stop button. 

Note
If you want to continue from the 
point where you stop an 
animation, use the Play/Pause 
button to pause it, instead of the 
Stop button, because the Stop 
button resets an animation to the 
first frame. 

The Next button advances to the next keyframe in the 
animation. 

The Prev button returns to the previous keyframe in the 
animation. 
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To return to first keyframe in your 
animation: 

• Hold down the Alt/Option key and press 
the Prev button.

Rendering an Animation 
When you’ve developed an animation of 
camera movements around your Canoma scene, 
the next step is to render it as a QuickTime 
movie or as a set of sequential image files. 

When an animation is rendered, Canoma 
automatically creates a folder into which it 
saves any associated animation files. To render 
an animation, Quicktime 3.0 must be installed. 
Quicktime 3.0 is available on the Canoma CD, 
or can be downloaded at www.apple.com. 

Remember, you can always load Canoma 
animation files into a motion-graphics 
application, where you can add effects and 
perform other post-production tasks. Refer to 
“Rendering Animations” on page 63 for 
instructions on how to render your animation. 
112 Creating Animations 



10  

Advanced
Modeling

Modeling Objects 
Canoma is great for generating models of 
man-made objects, almost on any scale—from 
objects on top of a tabletop, to furnished 
interiors and buildings, to entire cities. 

Canoma is not aimed at modeling highly 
irregular or complex objects, such as 
mountains, trees or human beings. 
MetaCreations has other great software for 
doing all of those, such as Bryce 3D for 
landscapes and Poser 3 for human models. 

Canoma works by combining well known 
techniques of perspective projection, first 
discovered during the renaissance in Italy, 
with the latest in mathematical techniques and 
interactive user interface design. 

Requiring relatively little user input, Canoma 
tries to find parameters such as: 

• camera location

• focal length (zoom)

• object positions



• object orientations

• object dimensions. 

Initially, most parameters are free to take on 
any value. The process of mapping 3D objects 
by adding pins, beads or glue constrains 
parameters into taking on correct values. 

As you begin modeling—and while you have 
only very few pins or beads placed on the 
wireframe objects—there may be a lot of 
parameter combinations that could satisfy your 
constraints. When that is the case, objects may 
seem to rotate freely or change depth 
arbitrarily. But, as you add more constraints, 
you will literally “pin down” the parameter 
needs for your model. 

Adding Source Images

For most projects many photographs are 
available. In general, that is preferable, because 
multiple images provide views from different 
angles, making determination of perspective 
and object dimensions more accurate. 
Sometimes, only one source image is available. 
For the single image case, it is often important 
to provide additional information to Canoma. 

For example, when you create an object, you 
have a choice of creating it on the ground plane 
or on top of another object. You can also tell 
Canoma that a new object has the same 
orientation as the currently selected one. By 
default, objects rotate independently. By telling 
Canoma that two objects have the same 
orientation, Canoma has to figure out one less 
parameter (rotation.) 

Perspective projection can be ambiguous. For 
example, does an object appear to be large 
because it is very close to the camera (but small 
in size) or does it appear to be small because it 
is far away from the camera (but huge in size.) 
Both might look the same on a photograph. 
Because of this, additional information must be 

provided in the form of “on creation” 
constraints or subsequent pin, bead or glue 
constraints. 

If you only have a single image project, the “on 
creation” constraints become essential, and it is 
advisable to learn and use them. If multiple 
images are available, these initial constraints 
become less critical, although they can still be 
very useful for improve model accuracy. While 
the mathematics of these constraints can be 
complicated, their appearance and meaning is 
easily understood. It is not necessary to have a 
deep understanding of the mathematics to 
effectively make models with Canoma. 

Free vs. Constrained Parameters

Usually scenes are modeled from the ground 
up. Working from a ground plane, you place 
objects on the ground, then place objects on 
top of those, and so on. By default, you cannot 
have an object just “floating in space.” These 
restrictions make modeling a lot easier. 

Each object in the Canoma world has a location 
in three-dimensional space (called the origin, 
with an x, y, and z coordinate). Each object has 
three rotation parameters to define its 
orientation in space. Finally, each object has a 
number of additional parameters based on its 
type. For example, a box may have width (the X 
axis), height (the Y axis), and length (the Z axis), 
whereas a rectangle has only length and width. 

The task Canoma has is to figure out reasonable 
values for all these parameters. To reduce the 
workload, by default we reduce the number of 
parameters that have to be determined. So, 
objects are created on the ground plane (fixing 
their origin Y-coordinate to 0) and can only 
rotate around a vertical axis, fixing the other 
two rotation angles at 0. degrees. 
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When you create an object on top of another 
object, again its origin’s Y (height) coordinate is 
not free, but bound to however high its base 
object is. If you create an object aligned with 
another one, instead of having to figure out 2 
vertical axis independent rotations, Canoma 
only has to find a single, common rotation 
angle. The more information you can provide 
about an object when it is created, the better. 

In general, the default constraints are useful, 
sometimes you may have to change them: for 
example if you know an object is not sitting on 
the ground plane or if it has an arbitrary 
orientation. In those cases you can “unlock” 
some or all of the fixed parameters. 

For example, to allow an object to float up or 
down arbitrarily, unlock its origins Y-
coordinate. To allow it any orientation in space, 
unlock all rotations. You should really only do 
this when you have multiple images of the 
object from different angles, since Canoma now 
needs more information, since it has more 
parameters to figure out.

In general, the more (correct) information you 
provide to Canoma the better. Use the “on 
creation” constraints (on Floor/on Top, aligned, 
concentric etc.) whenever you can and only 
place pins or beads where you can actually see 
object corners or edges. 

Misleading Canoma and 
Stressing a Model

It is also important not to “mislead” Canoma. 
For example, if you tell it a block has the same 
orientation as another one, but they really do 
not, then Canoma will yield inaccurate results 
and the model will feel “stressed” or unnatural. 
The same is true for pins or beads that you 
place—if you do not see a corner of an object, 

don’t place a pin where you think it might be, 
since chances are you will not be putting it into 
the right place. 

Canoma does not know that you’re estimating a 
corner and instead tries to accommodate your 
input as “the truth”. Misleading pins can cause 
inaccurate models and unexpected 
discrepancies between the displayed wireframe 
and the 3D preview. There is a Stress Display, 
in case you notice such discrepancies. This 
display helps pinpoint which pins or beads feel 
the most “wrong” to Canoma and might have 
been placed by accident or as the result of an 
incorrect guess. Refer to “Avoiding Model 
Stress” on page 92 for more information about 
using Canoma’s Stress Display. In these cases, 
you are better off deleting the offending pins or 
beads. 

In some cases, you can throw Canoma off 
spectacularly. For example if you glue the top of 
an object to the base of another one that is 
actually standing on the floor. The wireframe 
will move in big jumps in a proverbial “boing” 
like motion. If this happens, chances are high 
that you’ve provided some wrong input. It’s 
best to Undo (always available) and try again—
perhaps you just accidentally glued a wireframe 
to the wrong corner or edge. In Canoma, you 
can Undo up to 10 times in a row. You can also 
redo what you’ve undone. 

Listening to the Canoma 
“Heartbeat” 

Canoma is almost always “active”. Unlike a 
draw or a paint program, which only reacts 
when you have the mouse button down, 
Canoma tries to calculate decent parameter 
values, even after you let go of a pin or bead. 
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If your model is consistent and not under a lot 
of stress, this “heartbeat” is almost 
unnoticeable. Nothing much changes on the 
screen after you stop moving a constraint. 

On the other hand, if you provide inconsistent 
input, Canoma tries to find reasonable 
parameter values regardless of the incorrect 
pins or beads. When this happens, it can take a 
few seconds. During those seconds, you might 
see wireframes change—not just the object you 
manipulated, but potentially all the objects in 
your scene. Canoma tries to minimize the stress 
(or errors) across all objects simultaneously. A 
heartbeat display shows Canoma’s level of 
activity. 

Using Geometric Tricks 

If you are an architect or designer, you are 
probably familiar with geometry in your daily 
work. You can apply this knowledge to 
modeling in Canoma. 

For example, if you want to make a number of 
objects line up, just create a Guide Line object 
and glue those objects to the Guide Line. 

• If you only glue a corner of an object, that 
corner is on the Guide Line, but the 
orientation of the object is still arbitrary. 

• If you create an object aligned to a Guide 
Line or glue two corners of an object to a 
Guide Line, you’ve fixed the orientation of 
the object to be parallel with the Guide 
Line. 

You can also create a Guide Line or a Guide 
Line on top of another object and then glue 
one of its endpoints to a corner of another 
object that is floating in space. The other 
object’s corner is then forced to lie at the same 
height as the Guide Line (which by default is 
horizontal by the way.) This can be handy to 
constrain contour points on a translation sweep 

for example. Refer to “Objects with Editable 
Polyline Contours.” on page 81 for more about 
translation sweeps. 

If you want to make a box with equal length and 
width, just create a Guide Line, glue it to the 
corners along one side, duplicate the Guide 
Line object and glue the copy along the other 
side of the box. Since the Guide Line objects 
have the same lengths, they force the box to 
have equal length and width. 

You can create temporary helper objects just 
for the purpose of “attaching” other objects and 
later on delete the helper objects. Be careful 
though. As you delete the helper object, all of 
its constraints (such as glue) are deleted and 
this can cause (depending on how you 
constructed them) other objects to move. Guide 
Line helper objects are particularly useful 
because they do not show up in the 3D Preview 
or 3D file format exports, so you so not need to 
delete them. 

Another example of when a temporary object is 
useful is for establishing perspective. If you can 
see tiles on a floor, they might serve as a good 
starting point to establish perspective. Begin by 
modeling those. Later, after you add more 
objects, and maybe a ground plane or floor 
rectangle, you can delete the original helper 
tiles (since they are very close - coplanar - with 
the floor, leaving them in might cause 
rendering artifacts in the 3D preview or in 
exported file formats. 

If you are modeling a small object on a tabletop 
that does not really have very explicit shapes 
(lots of bevels for example), just place a 
cardboard box (like the one this software came 
in) alongside your “difficult” object. Model the 
cardboard box first to establish perspective and 
then continue with your actual objects. Later, 
you can delete the box (or “scaffold”) object. 
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Establishing Perspective
Starting Simple

Start modeling with simple objects first, like 
boxes. These have few internal parameters and 
help establish a perspective—the camera 
position, orientation, and focal length—for 
your scene. 

Starting with a box is always a good idea. Don’t 
start with a translation sweep, a polygon, or a 
curtain. Refer to “Objects with Editable 
Polyline Contours.” on page 81 for more about 
those objects. These have too many “free” 
parameters and do not help establish a good 
camera perspective. 

Modeling the First Image

It’s tempting to load in all your images, do a box 
in one image, switch to another image, try to 
pin the box there, then go back to the first 
image to create another object. This is not the 
best way to get good results. 

Choose a good first picture, one that shows a lot 
of your scene. Model a few objects in that 
picture, maybe 3 to 10, before even thinking 
about loading additional images. Once you’ve 
done some modeling, then add another image. 
Using this method, it is easier for Canoma to 
orient models correctly, because it is less likely 
to confuse rough alignment orientation, than 
when only one Box or Rectangle is present. 

Using Temporary “Helper” 
Objects

Use temporary objects to “bootstrap” 
perspective. For example, suppose there is a 
staircase or translation sweep that needs to be 
modeled as part of your scene. Try using a box 
for that element and pinning it into place, even 
though you know you’ll replace it later with the 
staircase or translation sweep. 

Use simple objects to establish camera perspective. 

Model several objects in the first picture, before loading in 
additional photos. 
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Just having the box there initially helps 
Canoma establish perspective. After a 
perspective is determined, adding more objects 
"solidifies" it to such an extent that the 
temporary helper object can then be deleted.

Creating the Same 
Orientation
Sometimes several objects will share the same 
orientation. A good example of this is 
skyscrapers in a typical american grid-like city 
layout. When this is the case, let Canoma know. 

Select one object whose orientation is the same 
as the one you are about to create. When you 
create the new object, hold down the Shift key. 
The two objects will then always be at the same 
orientation. This improves the quality of your 

3D model. It also improves the accuracy of 
Canoma, since there will be fewer independent 
parameters (rotations in this case) to calculate. 

Temporary objects help establish perspective. 

Select an object whose orientation is the same as the object 
you are about to create, then use Shift-Create on top to 
lock in that orientation. 

With orientation locked to first object. 
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Duplicating Objects with 
the Same Dimensions
When you duplicate objects that have the same 
dimensions, it results in a more precise model. 
This is especially useful if you have only one 
source image. 

In the following example, all the balconies are 
known to be of equal size. After the first box 
was created and pinned, Edit menu > 
Duplicate was used for subsequent balconies. 

In this case, since the balconies are not only the 
same size but even share the same orientation, 
Shift-Cmd/Ctrl-(D)uplicate can be used to 
create aligned clones. If you wanted to get extra 
fancy you could put spacer objects (like a Guide 
Line) between them, also duplicated, to ensure 
that equal spacing between the boxes is also 
maintained. That's not necessary in this case, 
but could be handy in other circumstances. 

Freeing Necessary 
Parameters
Each object in your model has parameters, 
such as a location in three dimensions (X,Y,Z) 
and an orientation (3 angles). In addition, each 
object has type-specific parameters. For 
example, a box has length, width and height. 
Canoma tries to calculate out all these 
parameters. To make it easier, Canoma fixes 
certain parameters to begin with. 

For example, all objects are by default created 
on the ground plane, i.e. their Y-location is 
initially fixed at 0 (except for on-top objects, 
which start life at Y=height of their base object.) 
Similarly, objects are by default only able to 
rotate around their vertical axis (the X-axis). 
The other two orientation angles are held fixed 
at 0 degrees. In many situations that works just 
fine, but sometimes you’ll need to free some of 
these parameters to avoid getting a wrong 
model. 

A typical "problem" case is a computer 
monitor. You might be tempted to model the 
computer screen in front of you. But if you look 
closely, the monitor is usually on a stand, so it 
does not rest on the table plane, but rather 
slightly above it. Second, a monitor is usually 
tilted slightly backwards. 

To selectively free up necessary parameters:

• Select Model menu > Unfix Y parameter. 
This allows an object to float in height, just 
what is needed for the monitor to rise a 
little above the table. 

• Select Model menu > Unfix all rotations 
or bring up the Object Information dialog 
for that object and click the Unfix all 

All the balconies are known to be of equal size. 
119 Canoma



Rotations button. This allows a selected 
object to freely rotate in space, like tilting 
the monitor backwards. 

Refer to “Checking Object Information” 
on page 85 for more about setting object 
parameters. 

Be careful. Freeing parameters comes at a cost. 
In order to figure out what the height or the 
other rotations should be, Canoma needs more 
information. This can come from additional 
source images or you may be able to use glue as 
described later in this chapter. To be safe, only 
unfix parameters when you have multiple 
source images with which to work.

Monitoring Stress in the 
Model
When you specify pins and beads in your 
source images, imagine that you are applying 
little springs between where you place them 
and the wireframe beneath. As long as the pins 
and beads are consistent with perspective 
projection, everything is fine. But in theory, you 
can pull a corner of a box to some wildly wrong 

location. The wireframe follows (beads try to, 
but will eventually separate from their edge). 
When this happens, the underlying 3D model 
is no longer be what you expect. 

Normally, this does not happen, but it can in 
the following circumstances: 

1 You model a beveled or round object and 
cannot see corners, so you "guesstimate" 
where the pins should be. You could guess 
wrongly. 

2 You misinterpret the wireframe and put a 
pin in a spot where it really just should not 
be. 

A good way to monitor model stress is to use 
the Stress Display frequently. Turn the Stress 
Display On to check for differences between 
the wireframes you placed and the 3D objects 
Canoma constructed according to your pin and 
bead “instructions.” 

Another way to detect stress is to watch when 
you delete a suspected pin or bead, if the 
wireframe jumps a lot before settling down 
again (the proverbial "boing" in our spring 
analogy), something is wrong. You can always 
undo the deletion to see if another pin on the 
object is the real culprit. 

Unfix all rotations in order to position the monitor. 
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Canoma tries to minimize stress across all the 
pins and beads that you place. Sometimes a 
single wrong pin can introduce a lot of stress. It 
is best to either delete or correct that wayward 
pin. 

Using Glue to Align 
Objects 
If you know that certain objects are connected, 
you can tell Canoma, just by using glue. This is 
useful when you have only a single source 
photograph in your project. When you have 
multiple photographs, Canoma can usually 
figure out on its own that objects are supposed 
to be connected. 

For increased model quality, it can still be a 
good idea to add this information via glue. The 
usefulness and techniques for creating glue will 
now be explained in more detail. 

Using Point To Point Glue

Sometimes a single wrong pin can introduce a lot of stress. 
Here, the lower left pin causes stress, because the building 
sits on a slope. 

Tip
To create aligned objects, you can 
use the Align option when 
creating an object. Glue, however, 
is more flexible and allows 
objects to actually be connected, 
not just aligned. 

Glue point to point by Ctrl-dragging one point over the 
other. 

Done. The object moves to satisfy the glue and shows a 
circle as feedback that there is glue between points. 
121 Canoma



Don’t "overglue" To attach the second rectangle and force it to 
be the same height as the first vertical one, glue 
their adjoining bottom corners together. There 
is no need to put glue at the top corners. The 
final glue is applied at the far left corner. 

Typical situation. Several rectangles are joined using glue. 

The first rectangle is joined using 2 point to point glue 
operations. You can see the rings indicating glue. 

Attaching the second rectangle. 

A box with a roof created on top of it.   
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Glue one corner of the roof.   

Then another.   

And, finally a third. Three is enough, that determines the 
orientation and size of the roof's base.    

Once the roof base is glued, you can pull up the roof to the 
desired height with a bead (or you could use pins at the 
corners).    
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Using Point to Edge Glue

When the points of two objects do not 
coincide, but you know that the point of one 
object lies on the edge of the other object, you 
can use Point to edge glue. 

The object moves to satisfy the glue and shows 
a circle to indicate that there is glue between 
the points. The glued object can still slide along 
the edge, but the corner point always stays on 
the edge. 

Point to edge glue can also be applied when a 
glued object isn’t actually touching the other 
object. Since the glued object is free to slide 

along the edge, it can even slide "off" the edge. 
(In fact, mathematically it still slides along the 
extension of the edge.) 

Another way to do align two objects is to create 
a Guide Line object (which is only visible in 
wireframe mode, so you don't need to worry 
about it messing up your model), then glue 
both object’s front corners to the Guide Line 
object. 

• Positioning an Object on the Side of 
Another. 

Create point to edge glue by Ctrl-dragging one point over 
the other object’s edge. 

Done.   

A glued object can slide along or even off an edge.   

In this case, the two object fronts are aligned.   
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Creating a Balcony

This technique allows a new object to be 
attached entirely within the face, rather than to 
the edges of another object. 

Here is an aligned box (created using Shift during 
creation). Its corners are glued to the indicated vertical 
edges of the other box. 

The result after gluing. The bottom of the new box is still 
fixed to the ground plane. But you can let if float up by 
selecting Model menu > unfix Y parameter, then use some 
beads to move the bottom of the box upwards. 

And this is the result. The new box is attached very neatly 
to the big box and can slide up or down as required. 

Use an Edge-to-edge glue. Ctrl-click the top back edge of 
the small box and glue it to each of the front vertical edges 
of the big box as indicated. 
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The small box's back is now forced to lie on the 
side face of the big box. It is still sitting on the 
ground plane. Once again, select Model menu 
> unfix Y parameter and use beads to move the 
little box upwards. 

The result after 2 Edge-to-edge glue operations.   

Voila1 A balcony, neatly glued to the side of a big box, but 
still free to slide up or down and to change width and 
height.   

A real world example. The two balconies were modeled 
using this technique. 
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MetaCreations Limited Use License Agreement

By using this software you are agreeing and indicating your 
acceptance of these terms and conditions. If you do not agree 
with them you should return the software to the dealer from 
whom you purchased the product and your money will be 
refunded. If the dealer from whom you purchased this 
package fails to refund your money, contact MetaCreations 
Corp. immediately at the address below. MetaCreations Corp. 
(hereinafter referred to as Company), a Delaware-based 
Corporation, provides the computer software (hereinafter 
referred to as Program) contained on the medium in this 
package and licenses its use. You assume full responsibility 
for the selection of the Program to achieve your intended 
results and for the installation, use and results obtained from 
the Program. 

License

A. In consideration of the payment of a license fee, you are 
granted a personal, non-transferable and non-exclusive 
license to use the Program under the terms stated in this 
Agreement. You own the diskette or other physical media on 
which the Program is provided under the terms of this 
Agreement, but all title and ownership of the Program and 
enclosed related documentation (hereinafter referred to as 
Documentation), and all other rights not expressly granted to 
you under this Agreement, remain with the Company. 

B. The Program may be used by you only on a single 
computer. Therefore, you must treat this software just like a 
book. With the exception of Item D below, "just like a book" 
means that this software may be used by any number of 
people and may be freely moved from one computer location 
to another, so long as there is no possibility of it being used 
at one location while the same copy is at the same time being 
used at another location. Just as the same copy of a book 
cannot be read by two different people in two different 
places at the same time, neither can the same copy of 
software be used by two different people in two different 
places at the same time. Site licenses for multiple single users 
are available. Contact MetaCreations Corp. for details. 

C. You and your employees and agents are required to 
protect the confidentiality of the Program. You may not 
distribute or otherwise make the Program or Documentation 
available to any third party. 

D. You may not copy or reproduce the Program or 
Documentation for any purpose except to make one (1) 
archival copy of the Program, in machine readable or printed 
form, for backup purposes only in support of your use of the 
Program on a single computer. You must reproduce and 
include the Company copyright notice on the backup copy of 
the Program. 

E. Any portion of the Program merged into or used in 
conjunction with another program will continue to be the 
property of the Company and subject to the terms and 
conditions of this Agreement. You must reproduce and 

include Company's copyright notice on any portion merged 
in or used in conjunction with another program. 

F. You may not sublease, assign or otherwise transfer the 
Program or this license to any other person without the prior 
written consent of Company. 

G. You acknowledge that you are receiving a LIMITED 
LICENSE TO USE the Program and Documentation and 
that the Company retains title to the Program and 
Documentation. You acknowledge that Company has a 
valuable proprietary interest in the Program and 
Documentation. You may not use, copy, modify or transfer 
the Program or Documentation or any copy, modification or 
merged portion in whole or in part except as expressly 
provided for in this Agreement. If you transfer possession of 
any copy, modification or merged portion of the Program or 
Documentation to another party, your license is 
automatically terminated. 

H. If you have purchased a NETWORK version of the 
software, this License Agreement applies to the installation 
of the software onto a single file server. It may not be copied 
onto multiple systems. Each node connected to the file server 
must also have its own node copy of the software that 
becomes a license for that specific user. 

Term

This license granted to you is effective until terminated. You 
may terminate it at any time by returning the Program and 
Documentation to Company together with all copies, 
modifications and merged portions in any form. The license 
will also terminate upon conditions set forth elsewhere in 
this Agreement, or if you fail to comply with any term or 
condition of this Agreement. You agree upon such 
termination to return the Program and Documentation to 
Company together with all copies, modifications and merged 
portion in any form. Upon termination, Company can also 
enforce any rights provided by law. The provision of this 
Agreement which protects the proprietary rights of Company 
will continue in force after termination. Termination of this 
license, either voluntary or involuntary, does not entitle you 
to a refund of your purchase cost except as provided 
elsewhere in this License Agreement.

Limited Warranty

Company warrants, as the sole warranty, that the medium on 
which the Program is furnished will be free from defects in 
materials and workmanship under normal use and 
conditions for a period of ninety (90) days from the date of 
delivery to you as evidenced by a copy of your receipt. No 
distributor, dealer or any other entity or person is authorized 
to expand or alter either this warranty or this Agreement. 
Any such representations will not bind the Company. 
Company does not warrant that the functions contained in 
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the Program will meet your requirements or that the 
operation of the Program will be uninterrupted or error-free. 
Except as stated above in this section, the Program and 
Documentation are provided as-is without warranty of any 
kind either expressed or implied, including but not limited to 
the implied warranties of merchantability and fitness for a 
particular purpose. You assume entire risk as it applies to the 
quality and performance of the Program and Documentation. 
Should the Program prove defective you (and not Company, 
authorized Company Distributor or dealer) assume the entire 
cost of all necessary servicing repair or correction. This 
warranty gives you specific legal rights and you may also have 
other rights which vary from state to state. Some states do 
not allow the exclusion of implied warranties, so the above 
exclusion may not apply to you. 

Limitation of Remedies

Company's entire liability and remedy will be: 

A. The replacement of any medium not meeting Company's' 
Limited Warranty' explained above and which is returned to 
Company or an authorized Company distributor or dealer 
with a copy of your receipt; or 

B. If Company is unable to deliver a replacement medium 
which conforms to the warranty provided under this 
Agreement, you may terminate this Agreement by returning 
the Program and Documentation to Company, authorized 
Company Distributor, or dealer from whom you obtained the 
Program and your license fee will be refunded. 

Product Returns

If you must ship the Program and Documentation to an 
authorized Company Distributor, dealer or to Company, you 
must prepay shipping and either insure the Program and 
Documentation or assume all risk of loss or damage in 
transit. To replace a defective medium during the ninety (90) 
day warranty period, if you are returning the medium to 
Company, please send us your name and address, the 
defective medium and a copy of your receipt at the address 
provided below. In no event will Company be liable to you for 
any damages, direct, indirect, incidental or consequential, 
including damages for any lost profits, lost savings or other 
incidental or consequential damages arising out of the use or 
inability to use such Program and Documentation, even if 
Company has been advised of the possibility of such damages 
or for any claim by any other party. Some states do not allow 
the limitation or exclusion of liability for incidental or 
consequential damages so the above limitation or exclusion 
may not apply to you. In no event will Company liability for 
damages to you or any other person ever exceed the amount 
of the license fee paid by you to use the Program regardless 
of the form of the claim. 

US Government Restricted Rights

The Program and Documentation are provided with 
restricted rights. Use, duplication or disclosure by the US 
Government is subject to restrictions as set forth in 
subdivision (b) (3) (ii) of the Rights in Technical Data and 
Computer Software Clause at (252) 227-7013. Contractor/
Manufacturer is MetaCreations Corp., 6303 Carpinteria 
Avenue, Carpinteria, CA 93013.

General

This Agreement is governed by the laws of the state of 
California (except federal law governs copyrights and register 
trademark(s)). If any provision of this Agreement is deemed 
invalid by any court having jurisdiction, that particular 
provision will be deemed deleted and will not affect the 
validity of any other provision of this Agreement. Should you 
have any questions concerning this Agreement, you may 
contact MetaCreations Corp. at this address: 

MetaCreations Corp.

6303 Carpinteria Avenue

Carpinteria, CA 93013

(805) 566-6200 phone

(805) 566-6385 fax

©1999 MetaCreations Corp. All rights reserved. The 
MetaCreations logo and Canoma are trademarks of 
MetaCreations Corporation. MetaCreations is a registered 
trademark of MetaCreations Corporation. All other product 
names mentioned in the Program, manual or other 
documentation are used for identification purposes only and 
may be trademarks or registered trademarks of their 
respective companies. Registered and unregistered 
trademarks used herein are the exclusive property of their 
respective owners. MetaCreations Corp. makes no claim to 
any such marks, nor willingly or knowingly misused or 
misapplied such marks. 
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